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Getting Started i

Getting Started
The tutorials that follow provide a brief introduction to both the user 
interface and the calculation capabilities of Spartan Student. The 
intent is to provide hands-on experience with the user interface and 
in doing so, illustrate the set up, submission, and interpretation of 
molecular mechanics and quantum chemical calculations. Tutorials 
are not intended to illustrate the full range of capabilities available 
in Spartan Student, but focus on building and sketching a variety 
of molecules and on use of the program to calculate equilibrium and 
transition-state geometries, to search conformation space, to align 
molecules, to evaluate reaction thermochemistry and activation 
energetics and to obtain NMR and infrared spectra.

Walking Through Spartan Student (Tutorial 1) provides a “guided 
tour” introducing rudimentary program operations. No molecules 
are sketched (2D) or built (3D) and no calculations are performed. 
Rather, molecular structures, properties and spectra resulting from 
previous calculations are examined, as are graphical models for the 
description of charge distribution and chemical reactivity.

Sketching Organic Molecules (Tutorial 2) and Building Organic 
Molecules (Tutorial 3) present alternative ways to specify molecular 
structure, the first step in performing a molecular mechanics or 
quantum chemical calculation. The advantage of 2D sketching over 
3D building becomes more and more evident as molecular size and 
complexity increase, and with the rapidly growing popularity of 
touch-screen tablets and Windows PC’s. The 3D building paradigm 
is quite general and Spartan Student provides tools not only for 
building organic molecules (described in Tutorial 3) but also for 
inorganic and organometallic molecules and for polypeptides and 
polynucleotides. The tutorials in these chapters are limited to building/
sketching and do not involve either calculations or examining the 
results of calculations.

The tutorials in Spectra, Properties, and Graphical Models of Organic 
Molecules from the Database (Tutorial 4) and Spectra, Properties 
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and Graphical Models from Quantum Chemical Calculations 
(Tutorial 5) make use of the same molecules sketched or built in the 
previous chapters, but with focus on obtaining and interpreting the 
results of calculations.

The tutorials in Groups of Organic Molecules (Tutorial 6) introduce 
multi-molecule documents and associated spreadsheet, plotting and 
analysis tools available in Spartan Student. In order to save time, 
no quantum chemical calculations are required with all results being 
drawn from the database (Spartan Spectra Properties Database).

The tutorials in Spectra of Organic Molecules (Tutorial 7) further 
illustrate the use of Spartan Student to interpret infrared spectra and 
to assist in the assignment of NMR spectra.

All of the molecules considered up to this point are either rigid or 
have been assumed to exist in a single conformer. In reality, most 
molecules can adopt more than one conformation. The tutorials 
in Flexible Molecules (Tutorial 8) illustrate how to examine the 
conformational profile of a molecule with only a single rotatable 
bond, how to assign the lowest-energy conformer of a molecule with 
multiple degrees of freedom and how to interpret the NMR spectrum 
of a flexible molecule. 

Organic Reactions (Tutorial 9) illustrates two approaches available 
in Spartan Student for finding the transition state for an organic 
reaction. The first starts from a guess based on the structure of the 
reactant together with a set of “reaction arrows”, while the second 
moves a geometric variable through the transition state.

Applications to proteins and nucleotides are provided in Biomolecules 
(Tutorial 10). Access to the PDB is illustrated.

Finally, Inorganic and Organometallic Molecules (Tutorial 11) 
illustrates the inorganic model kit available in Spartan Student. An 
example of a transition state for an organometallic reaction is also 
provided.



Table of Contents iii

Table of Contents
Tutorial 1 Walking Through Spartan Student ...................  1

Tutorial 2 Sketching Organic Molecules ...........................  20
 Sketch Palette .......................................................  20
 Sketching a Molecule...........................................  21
 Manipulating a Sketch .........................................  21
 1. N,N-Dimethylaniline ......................................  22
 2. trans-Stilbene ..................................................  22
 3. Indigo ..............................................................  23
 4. 3-Cyano-4-methylcyclohexenyl Radical ........  24
 5. Androsterone ..................................................  25

Tutorial 3 Building Organic Molecules ..............................  28
 Organic Model Kit ...............................................  28
 1. Acrylonitrile ....................................................  31
 2. Cyclohexanone ...............................................  33
 3. Limonene ........................................................  33
 4. Nicotine ..........................................................  34

Tutorial 4 Spectra, Properties and Graphical Models of
 Organic Molecules from the Database .............  36
 1. Limonene ........................................................  36
 2. Indigo ..............................................................  38
 3. trans-Stilbene ..................................................  39
 4. Nicotine ..........................................................  40
 5. N,N-Dimethylaniline ......................................  42
 6. Androsterone ..................................................  43

Tutorial 5 Spectra, Properties and Graphical Models of
 Organic Molecules from Quantum Chemical
 Calculations ........................................................  45
 1. Acrylonitrile ....................................................  45
 2. Cyclohexanone ...............................................  50
 3. 3-Cyano-4-methylcyclohexenyl Radical ........  52



iv Table of Contents

Tutorial 6 Groups of Organic Molecules ...........................  55
 Dienophiles in Diels-Alder Cycloadditions .........  56
 Addition vs. Substitution .....................................  60
 Acidities of Carboxylic Acids ..............................  62

Tutorial 7 Spectra of Organic Molecules ...........................  65
 Infrared Spectrum of Methyl Formate .................  65
 Proton NMR Spectrum of 1-Methylindole ..........  68
 13C Spectrum of Cytisine .....................................  71
 Stereochemical Assignments from 13C Spectra....  73

Tutorial 8 Flexible Molecules ..............................................  75
 Internal Rotation in Dimethylperoxide ................  75
 Ethinamate ...........................................................  79
 13C Spectrum of cis-1,2-Dimethylcyclohexane....  80

Tutorial 9 Organic Reactions ..............................................  83
 Ene Reaction of 1-Pentene ...................................  84
 SN2 Reaction of Bromide and Methyl Chloride ...  87

Tutorial 10 Biomolecules .......................................................  92
 Structural Motifs in Proteins ................................  92
 Structure of DNA .................................................  97

Tutorial 11 Inorganic and Organometallic Molecules........  100
 Sulfur Tetrafluoride ..............................................  100
 Benzene Chromium Tricarbonyl ..........................  103
 Ziegler-Natta Polymerization of Ethylene ...........  105



Tutorial 1 1

Tutorial 1
Walking Through  
Spartan Student

This tutorial introduces a number of basic operations in Spartan 
Student required for molecule manipulation, property query and 
spectra and graphics display. Specifically it shows how to: i) open 
molecules, ii) view different models and manipulate molecules on 
screen, iii) measure bond distances, angles and dihedral angles, 
iv) display energies, dipole moments, atomic charges and infrared 
and NMR spectra, and v) display graphical surfaces and property 
maps. Spreadsheet operations are not illustrated, molecules are not 
sketched or built and no calculations are performed.

1. Start Spartan Student. Click (left mouse button) on File from 
the menu bar that appears at the top of Spartan Student’s main 
window. Click on Open... from the File menu that appears. 
Alternatively, click on the  icon that appears at the top of the 
screen. A file browser appears.

Tap on  at the top of the screen. If the icon is not available, 
tap on File in the menu bar to bring up a palette of icons and 

then tap on .

 Move to the Tutorials directory*, click on Walking Through 
Spartan Student and click on Open. 

* For Windows, the Tutorials directory is found in Program Files/Wavefunction/Spartan 
Student. It needs to be copied and saved to another location to access. For Macintosh, the 
Tutorials directory is on the Spartan Student disc image. Copy and save this to the desktop.



2 Tutorial 1

Tap on Walking Through Spartan Student and tap on Open. 
Note that click (left mouse button) and tap (one finger) are 

equivalent as are double click and double tap. We shall only 
indicate click/double click thoughout the text that follows.

 A single document containing ethane, acetic acid dimer, 
propene, ammonia, hydrogen peroxide, acetic acid, water, 
cyclohexanone, camphor, ethylene, benzene, aniline and 
cyclohexenone will be opened. A ball-and-spoke model for the 
first molecule (ethane) will be displayed; its name will appear 
at the bottom right of the screen. The appearance of the name 
means that the molecule is included in the ≈6,000 molecule 
subset of the Spartan Spectra and Properties Database (SSPD) 
installed with Spartan Student.

2. Practice rotating (move the mouse while holding down the left 
button), rotating in the plane of the screen (move the mouse 
while holding down both the left button and the Shift key), 
and translating (move the mouse while holding down the right 
button). Use the scroll wheel to zoom in and out, or alternately 
move the mouse up or down while holding down both the right 
mouse button and the Shift key.

To rotate, move one finger across the screen. To rotate in the 
plane of the screen, twist two fingers. To translate, move two 

fingers across the screen. To zoom in, pinch two fingers together. 
To zoom out, move two fingers apart.

 Click on Model from the menu bar.
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  Wire Ball-and-Wire Tube Ball-and-Spoke

 One after another, select Wire, Ball and Wire, Tube and finally 
Ball and Spoke from the palette of icons that results from 
selection of the Model menu. All four models for ethane show 
roughly the same information. The wire model looks the most 
like a conventional line formula. It uses color to distinguish 
different atoms, and one, two and three lines between atoms to 
indicate single, double and triple bonds, respectively.

 The ball-and-wire model is identical to the wire model, except 
that atom positions are represented by small colored spheres, 
making it easy to identify atom locations. The tube model is 
identical to the wire model, except that bonds are represented by 
solid cylinders. The tube model is better than the wire model in 
conveying three-dimensional shape. The ball-and-spoke model 
is a variation on the tube model; atom positions are represented 
by colored spheres, making it easy to see atom locations.

 Select Space Filling from the palette of icons that results from 
the selection of Model menu.
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 Space-Filling

 The space-filling model is different from the other models in 
that bonds are not shown. Rather, each atom is displayed as a 
colored sphere that represents its approximate size. Thus, the 
space-filling model provides a measure of molecular size. While 
lines between atoms are not drawn, the existence (or absence) 
of bonds can be inferred from the extent to which spheres on 
neighboring atoms overlap. If two spheres substantially overlap, 
then the atoms are almost certainly bonded, and conversely, 
if two spheres barely overlap, then the atoms are not bonded. 
Intermediate overlaps suggest weak bonding, for example, 
hydrogen bonding.

3. Click once on the right arrow key  at the bottom left of the 
interface. This will move to the next molecule in the document, 
acetic acid dimer. Its name will appear at the bottom of the 
screen. If you make a mistake, use the backward  or forward 

 step keys to access acetic acid dimer in the document. Switch 
to a space-filling model and look for overlap between the (OH) 
hydrogen on one acetic acid molecule and the (carbonyl) oxygen 
on the other. Return to a ball-and-spoke model. Click on the 
Model menu and select Hydrogen Bonds.

 
 Ball-and-Spoke model for acetic acid dimer  

with hydrogen bonds displayed

 The two hydrogen bonds responsible for holding the acetic acid 
molecules together will be drawn.
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 Use the 3 key to toggle between stereo 3D and standard display. 
To view in 3D you will need to wear red/blue glasses.

4. Distances, angles, and dihedral angles can easily be measured 
with Spartan Student using Measure Distance, Measure 
Angle, and Measure Dihedral (respectively), from the 
Geometry menu.

 
a) Measure Distance: This measures the distance between 

two atoms. Click once on  to move to the next molecule, 
propene. Click on the Geometry menu and select Measure 
Distance (or click on the  icon if it appears at the top of 
the screen). Click on a bond or on two atoms (the atoms do 
not need to be bonded). The distance (in Ångstroms) will 
be displayed at the bottom right of the screen. Repeat the 
process for different bonds or pairs of atoms. When you 
are finished, select View from the Build menu (or click on 
the  icon at the top of the screen).

  
b) Measure Angle: This measures the angle around a central 

atom. Click once on  to move to the next molecule, 
ammonia. Click on the Geometry menu and select Measure 
Angle (or click on the  icon if it appears at the top of the 
screen). Click first on H, then on N, then on another H. 
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Alternatively, click on two NH bonds. The HNH angle (in 
degrees) will be displayed at the bottom right of the screen. 
Click on  when you are finished.

c) Measure Dihedral: This measures the angle formed by 
two intersecting planes, one containing the first three 
atoms selected and the other containing the last three atoms 
selected. Click once on  to move to the next molecule, 
hydrogen peroxide. Click on the Geometry menu and 
select Measure Dihedral (or click on the  icon if it 
appears at the top of the screen) and then click in turn on 
the four atoms (HOOH) that make up hydrogen peroxide. 
The HOOH dihedral angle will be displayed at the bottom 
right of the screen. Click on  when you are finished.

5. Energies, dipole moments, atomic charges, thermodynamic and 
QSAR properties (among other calculated data) are available 
from Properties under the Display menu.

 

Molecule Properties:

a) Molecule: Click once on  to move to the next molecule,  
acetic acid. Click on the Display menu and select Properties 
(or click on  icon if it appears at the top of the screen). 
The Molecule Properties dialog appears. It provides the 
energy and a host of other information relating to the isolated 
molecule. 
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 The energy for acetic acid is given in atomic units (Energy in 

au). The magnitude of the dipole moment (Dipole Moment 
in debyes) is also provided in the Molecule tab. A large 
dipole moment indicates large separation of charge. You can 
display the dipole moment vector,  where the + side 
refers to the positive end of the dipole, to the model on the 
screen, by checking the box to the left of Display Dipole 
Vector near the bottom of the dialog.

The vector will not be displayed if the dipole moment is zero. 
The dipole moment will not be reported if the molecule is charged 
because in this case it depends on the location and orientation of 
the molecule in space. 

b) QSAR: Quantitative structure - activity relationship  
properties including area, volume and polar surface area 
(and many others) may be accessed from the QSAR tab.

c) Thermodynamics: Thermodynamic properties including 
zero-point energy, entropy, enthalpy, Gibbs free energy, and 
heat capacity are available from the Thermodynamics tab.

d) 2-D Drawing: Spartan Student Edition will generate a 
2-D drawing for anything constructed in 2D or 3D (with a 
maximum limit of 100 atoms).
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e) Atomic Charges: To display the charge on an atom, click on it 
when the Molecule Properties dialog is on screen. The Atom 
Properties dialog replaces the Molecule Properties dialog.

 
 Atomic charges based on the electrostatic potential are 

given in units of electrons. A positive charge indicates a 
deficiency of electrons and a negative charge indicates an 
excess of electrons. Repeat for other atoms. Confirm that 
the positively-charged atom(s) lie at the positive end of the 
dipole moment vector. When you are finished, close the 
dialog by clicking on  at the top.

f) Infrared Spectra: Molecules vibrate (stretch, bend, twist) 
even at absolute zero. The infrared spectrum of a molecule 
arises due to transitions between ground and excited-state 
vibrational energy levels, that is, correspondence of the 
frequency of the light and the energy of vibrational excitation.  
Infrared spectroscopy is important for identifying molecules 
as different functional groups vibrate at noticeably different 
and characteristic frequencies. 

 Click once on  to move to the next molecule in the 
document, water. To animate a vibration, select Spectra 
from the Display menu (or click on  if it appears at the 
top of the screen). This leads to an empty spectra pane at the 
bottom of the screen.
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 Click on  at the top left of the pane and select  
from the available spectra.

  
 The calculated IR spectrum of water from 4000 - 500 cm-1 

appears in the pane.

 

 There are three lines, one of moderate intensity around 3728 
cm-1, one very weak around 3608 cm-1 and one very strong 
around 1623 cm-1. In turn, move the cursor on the spectrum 
(move the mouse while holding down the left mouse button 
over each of these lines). In response, the molecular model 
will vibrate. The line of moderate intensity corresponds to 
an asymmetric OH stretching motion, the very weak line 
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corresponds to a symmetric OH stretching motion and the 
strong line corresponds to the HOH bend.

 To translate the plot inside the pane, position the cursor over 
the spectrum and move the mouse left or right while holding 
down the right button. To expand or contract the scale of 
the IR plot from its default range, position the cursor over 
the spectrum and use the scroll wheel on your mouse (or 
alternatively move the mouse while holding down both 
the right button and Shift key). To reset the spectra plot to 
the original values, click on  in the bar at the top of the 
spectra pane.

 To see a complete listing of frequencies and intensities, click 
on  at the left of the spectra pane.

 

 Click on each entry in the table to highlight the frequency in 
the spectrum and animate the vibration. Click on  again to 
dismiss the table and click on  to remove the spectrum.

Changing the size of the spectra pane as well as translating 
and rescaling a spectrum is quite simple with touch screen 

operations. To resize the spectrum, position one finger inside the 
menu bar at the top of the spectra pane and move up or down. To 
translate the spectrum, move two fingers over the spectrum. To 
alter the scale, pinch two fingers over the spectrum.

 Click once on  to move to cyclohexanone, the next 
molecule in the list. The spectra pane is still on screen but 
should be empty. (If it is not on screen, select Spectra from 
the Display menu or click on  if it appears at the top of 
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the screen to restore.) Click on  in the bar at the top of the 
spectra pane and select . The calculated infrared 
spectrum of cyclohexanone appears.

 
 The spectrum obtained from quantum chemical calculations 

has been broadened (to account for finite temperature) and 
scaled (to account for the fact that the underlying energy 
function is assumed to be quadratic). The same broadening 
and scaling parameters are used for all molecules. The 
strongest line appears at 1759 cm-1 and corresponds to a CO 
stretch. The fact that the line is both intense and isolated 
from other features in the spectrum makes it a very useful 
indicator of carbonyl functionality. Move the cursor over this 
line and examine the “vibrating” model for cyclohexanone 
on screen above the spectrum.

 Click again on  and this time select . The 
experimental IR spectrum (from the public NIST database) 
is superimposed on top of the calculated spectrum.

 
 Note that the two spectra are quite similar. This would have 

not been the case with the raw calculated data, however, 
calculated frequencies and intensities have been empirically 
corrected to account for finite temperature and for systematic 
errors in the theory.

 When you are done, select  from the bar at the top of the 
spectra pane.
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e) NMR Spectra: Along with mass spectrometry, NMR 
spectroscopy is the most powerful tool available with which 
to assign molecular structure. Among the nuclei that exhibit 
NMR spectra, proton and 13C are by far the most important.

 Click once on  to move to the next molecule in the 
document, camphor. With the spectra pane on screen, click 
on  in the bar at the top of the spectra pane and select 

. The calculated 13C NMR spectrum appears.

 

 This comprises nine lines, in the range of 150 to 0 ppm 
(there is a tenth line corresponding to the carbonyl carbon 
at 217 ppm). You can zoom out to see this line by using the 
scroll wheel on your mouse. More instructive is to zoom 
in on the range from 60 to 0 ppm to get a better look at the 
other lines.

 Move the mouse while holding down the left button over the 
spectrum. When you come to a line, the chemical shift will 
appear at the top of the spectrum and the atom (or atoms) 
responsible for this line will be highlighted on the model 
displayed above the spectrum.
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 Again, click on on  in the bar at the top of the spectra 
pane and select . The experimental  13C spectrum 
obtained from a public database will be superimposed on 
top of the calculated spectrum.

 

 You will see that the overall agreement between calculated 
and experimental 13C spectra is quite good. As with infrared 
spectra (see preceeding discussion of cyclohexanone), the 
data resulting from the quantum chemical calculations 
have been empirically corrected (for density functional 
calculations only).

 Click again on on  and select . An “idealized” 
proton spectrum where three-bond HH coupling constants 
are set to zero appears.
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 The manipulations are as before and the hydrogens 
responsible for selected lines are highlighted in the model. 
No experimental spectrum is available, but the quality of 
the match would be expected to be similar to that previously 
observed with comparison of 13C spectra.

 Click again on on  and select  from the palette. 
The resulting spectrum which takes account of three-bond 
HH coupling is more complicated and much closer to what 
would be observed experimentally. Coupling constants and 
splitting patterns have not actually been calculated from 
quantum mechanics, but rather have been estimated based 
on local environment.

 
 Zoom in on specific lines (scroll wheel) to see the detailed 

splitting patterns. For example, the two protons at C3 are 
both split by the proton at C4. The doublet at 2.23 ppm 
shows a much larger splitting than the doublet at 1.99 ppm 
(you need to zoom way in to see that this is a doublet). This 
reflects the fact that the proton responsible for the line at 
2.23 ppm makes a dihedral angle of 43° with the proton at 
C4, whereas the proton responsible for the line at 1.99 ppm 
makes a dihedral angle of 80°.

 Finally, note that you can switch among the three calculated 
NMR spectra (as well as the experimental 13C spectrum) 
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for camphor by clicking on the associated button in the bar 
above the spectra pane. When you are done, remove all three 
spectra by clicking  three times in succession.

6. Spartan Student permits display, manipulation and query 
of a number of important graphical quantities resulting from 
quantum chemical calculations. Most important are the electron 
density (that reveals how much space a molecule actually takes 
up), the bond density (that reveals chemical bonds), and key 
molecular orbitals (that provide insight into both bonding and 
chemical reactivity). In addition, the electrostatic potential 
map, an overlay of the electrostatic potential (the attraction or 
repulsion of a positive charge for a molecule) on the electron 
density, is valuable for describing overall molecular charge 
distribution as well as anticipating sites of electrophilic addition. 
Another indicator of electrophilic addition is provided by the 
local ionization potential map, an overlay of the energy of 
electron removal (ionization) on the electron density. Finally, 
an indicator of nucleophilic addition is provided by the |LUMO| 
map, an overlay of the absolute value of the lowest-unoccupied 
molecular orbital (the LUMO) on the electron density.

 Click once on  to move to the next molecule in the list, 
ethylene. Click on the Display menu and select Orbital 
Energies (or click  if it appears at the top of the screen). An 
orbital energy diagram for ethylene will appear at the left of the 
screen. This provides the energies of all six occupied valence 
molecular orbitals and two unoccupied molecular orbitals.
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 Click on the energy level in the diagram labeled HOMO. In a 
second, the familiar π bond in ethylene will appear. Note that 
the graphic has “blue” and “red” regions. These correspond to 
positive and negative values of the orbital (the absolute sign 
is arbitrary). Examine the other occupied orbitals (by clicking 
on their respective energy levels in the diagram) as well as the 
lowest-unoccuped molecular orbital (the LUMO). Note that you 
can move from one level to the next by moving the mouse up or 
down while holding down and then releasing the left button.

“Swipe” one finger up or down over the orbital energy 
diagram to move to the next higher or lower energy level.

 Click once on  to move to the next molecule in the list, 
benzene. Click on the Display menu and select Surfaces from 
the palette (or click on  if it appears at the top of the screen). 
The Surfaces dialog appears.
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  Select electrostatic potential map inside the Surfaces dialog 
(click inside the box to the left of the name). An electrostatic 
potential map for benzene will appear. Click on the map. The 
Style menu will appear at the bottom right of the screen. Select 
Transparent from this menu. This makes the map transparent 
and allows you to see the molecular skeleton underneath. Go 
back to a Solid display (Style menu) in order to clearly see 
color differences. The surface is colored red in the π system 
(by convention, indicating negative potential and the fact that 
this region is attracted to a positive charge), and blue in the 
σ system (by convention, indicating positive potential and the 
fact that this region is repelled by a positive charge). Click 
on the Display menu and select Properties (or click on  
if it appears at the top of the screen) and click on the surface. 
Remove the checkmark from the box to the left of Bands in the 
Surface Properties dialog to replace the series of color bands 
(discrete display) by a continuous display.*

* Discrete displays are the default. You can change the default to continuous displays from 
the Molecule Preferences dialog (Preferences... under the Options menu; Chapter 10, 
Spartan Student Manual).
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 Click once on  to move to the next molecule in the list, aniline, 
and select local ionization potential map inside the Surfaces 
dialog. By convention, red regions on a local ionization potential 
map indicate areas from which electron removal (ionization) is 
relatively easy, meaning that they are subject to electrophilic 
attack. These are easily distinguished from regions where 
ionization is relatively difficult (by convention, colored blue). 
Note that the ortho and para ring carbons are more red than the 
meta carbons, consistent with the known directing ability of the 
amino substituent.

 Click once on  to move to the last molecule in the list, 
cyclohexenone, and select LUMO inside the Surfaces dialog. 
The resulting graphic portrays the lowest-energy empty 
molecular orbital (the LUMO) of cyclohexenone. This orbital 
is delocalized onto several atoms and it is difficult to tell 
where exactly a pair of electrons (a nucleophile) will attack the 
molecule.

 A clearer portrayal is provided by a LUMO map, that displays 
the (absolute) value of the LUMO on the electron density 
surface. First, remove the LUMO from your structure (select 
LUMO in the Surfaces dialog) and then turn on the LUMO 
map (select |LUMO|map in the dialog). By convention, the 
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color blue is used to represent maximum value of the LUMO 
and the color red, minimum value. Note that there are two blue 
regions, one directly over the carbonyl carbon and the other over 
the β carbon. This is entirely consistent with known chemistry. 
Enones may either undergo carbonyl addition or conjugate 
(Michael) addition.

 

HO CH3

CH3

OO

CH3Li
carbonyl addition

(CH3)2CuLi
Michael addition

7. When you are finished, close the document by selecting Close 
from the File menu or alternatively by clicking on the  icon 
if it appears at the top of the screen.
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Tutorial 2
Sketching Organic Molecules 

The tutorials in this section introduce and illustrate tools to sketch 
organic molecules in 2D and then to automatically convert them 
into realistic 3D structures.

Not only are 2D sketches or drawings more familiar to most chemists 
than 3D structures, they are often easier to produce especially for 
complex molecules that may incorporate fused rings or require 
stereochemistry to be defined. The advent of touch-screen computers 
makes the argument for sketching as an alternative to building even 
more compeling. Molecules that require several minutes to build in 
3D can be sketched in seconds. The key is automatic and reliable 
conversion from 2D drawings to 3D structures.

Sketch Palette

The sketch palette contains tools for making and manipulating 2D 
drawings, including tools for adding cues to designate stereochemistry.

These include atoms that are most commonly found in organic 
molecules (H, B, C, N, O, F, Si, P, S, Cl, Br and I), the phenyl, 
cyclohexyl and cyclopentyl rings and the carbonyl, acid/ester and 
amide functional groups. A More icon (immediately below H and B 
atoms) allows for entering additional elements and functional groups 
from a library. The palette also contains stereochemical markers and 
charge/radical markers.
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Sketching a Molecule

To start a sketch, first select (click on) an atom, group, ring or wildcard 
icon in the palette and then double click in the white portion of the 
screen (the drawing area). To draw a bond, first click on an atom, 
group, or ring icon in the palette to designate what is at the end of 
the bond, then position the cursor over the atom in the drawing area 
where you want the bond to start, move the cursor while holding 
down the left button (“drag” the cursor) to the place in the drawing 
area where you want the bond to end and release the button. Multiple 
bonds are made by dragging over existing bonds.

1. position

2. drag

3. release
gives

1. position

2. drag

3. release
gives

4. position 5. drag

1. position 2. drag 3. release
gives

5. drag 4. position6. release

6. release

To make a bond touch the screen where you want it to start, move 
one finger to where you want it to end and lift. Replace position by 

touch, drag by move and release by lift in the diagram above.

Manipulating a Sketch

To translate the sketch, move the mouse over the screen while holding 
down the right button. To rotate the sketch (in the plane of the screen), 
move the mouse up and down while holding down both the left button 
and Shift key. Use the scroll wheel to resize the sketch.

To translate the sketch, move two fingers over the screen. To rotate 
the sketch in the plane of the screen, “twist” two fingers on the 

screen. To resize the sketch, pinch (or spread) two fingers on the screen.
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N,N-Dimethylaniline

N

1. Select New Sketch from the File menu (or click on  if it 
appears at the top of the screen) to bring up the sketch pad. Click 
on  in the palette and double click on screen.

2. Click on  in the palette. Position the cursor over the “top” 
carbon on the benzene ring, drag it up and release. You have 
drawn aniline.

3. Click on  in the palette. Position the cursor over the nitrogen, 
drag it up and to the left and release.  is still selected. Again 
position the cursor over the nitrogen, drag it up and to the right 
and release.

4. Click on  in the palette to clean up your drawing and click on 
 to produce a 3D structure. The name N,N-dimethylaniline 

will appear at the bottom of the screen as the molecule is in the 
database.

5. Close N,N-dimethylaniline.

trans-Stilbene

1. Select New Sketch from the File menu ( ) to bring up the 
sketch pad. Click on  in the palette. Position the cursor on 
the screen, drag it to the right and release. Position the cursor 
on one end of the line (CC bond) that you have just drawn, drag 
it to the other end and release. You have drawn ethylene.
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2. Click on . Position the cursor over the left end of the double 
bond, drag it down and to the left and release. You have drawn 
styrene.

 
3.  is still selected. Position the cursor over the right end of the 

double bond, drag it up and to the right and release.

4. Click on  to clean up your drawing. Click on  to convert 
it to a 3D structure. The name trans-stilbene will appear at the 
bottom of the screen as the molecule is in the database.

5. Close trans-stilbene.

Indigo

N

N

O

H

H

O

7
7a6

5

4
3a 3

2 2'

1'

3a'

7a'

3' 4'
5'

6'

7'

1

1. Select New Sketch from the File menu ( ). Click on  and 
double click on screen. 

2.  is still selected. Position the cursor over C2 (see numbering 
in diagram above), drag it to the right and release. Your sketch 
should appear as below.

 

3. Select  from the palette. Position the cursor above C3, drag it 
away from the ring and release. Again position the cursor above 
C3, drag it along the CO bond to the oxygen and release. Repeat 
for C3'. You are left with a drawing.
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O

O

4. Select  from the palette and one after another double click 
on C1 and C1'.

 

N

N

O

H

H

O

5. Select  from the palette. Position the cursor above C2, drag 
it to C2' and release.

 

N

N

O

H

H

O

6. Select  from the palette and double click on the bond 
connecting C3a and C7a. Repeat for C3a' and C7a'.

7. Click on  to clean up your drawing and click on  to turn it 
into a 3D structure. The name indigo will appear at the bottom 
of the screen as the molecule is in the database.

8. Close indigo.

3-Cyano-4-methylcyclohexenyl Radical

3
2

6
5 4

1
CN•

1. Select New Sketch from the File menu ( ). Click on  in 
the palette and double click on screen. 

2. Click on  in the palette. Position the cursor over C4 (see 
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diagram above for numbering), drag it away from the ring and 
release. You have drawn methylcyclohexane.

3.  is still selected. Position the cursor over C1, drag to C2 and 
release. You have drawn 4-methylcyclohexene.

4. Double-click on the More icon that is located immediately below 
H and B in the palette, and then click on the Groups tab. Click on 
–CN in the upper right corner. CN now appears as the selected 
icon. Position the cursor over C3, and drag it away from the ring 
and release. You have drawn 3-cyano-4-methylcyclohexene.

5. One of these icons ( , , ) will appear in the palette directly 
below . If it is not , click on the icon until the icon is . 
Double click on C3. A “dot” (radical marker) will appear next to 
C3.

6. Click on  to clean up your drawing and click on  to make 
a 3D structure. The name will not appear at the bottom of the 
screen as this radical is not in the database.

7. Close 3-cyano-4-methylcyclohexenyl radical.

Androsterone
H3C

H

HH

H
HO

H3C

O

1
2

3
4

5

10 9 8

6
7

11
12

13
14

17
16

15

1. Select New Sketch from the File menu ( ) to bring up the 
sketch pad. Click on  and double click on screen. Cyclohexane 
is still selected. Double click on the 5-10 bond (see diagram 
above).
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2. Cyclohexane is still selected. Double click on the 8-9 bond.

 

3. Click on  and double click on the 13-14 bond. You have now 
drawn the complete steroid skeleton.

4. Click on , position the cursor over C10, drag up and release. 
Repeat for C13.

5. Click on . Position the cursor over C3, drag down and to the 
left and release. Position the cursor over C17, drag up and to the 
right and release. Convert the single (CO) bond at C17 to a double 
bond. Again position the cursor over C17, drag along the bond 
to oxygen and release.

6. It is necesary to explicitly specify hydrogens at C5, C8, C9 and 
C14 in order to incorporate the necessary stereochemical cues (up 
and down “wedges”) in your drawing. Click on , position the 
cursor over C5, drag away from the ring and release. Repeat for 
C8, C9 and C14.

7. Click on . Position the cursor over C10, drag along the bond 
to the methyl group that you drew in step 4 and release. Repeat 
for C13. Position the cursor over C8, drag along the CH bond 
that you drew in step 6 and release. Up wedges will appear for 
all three centers.

8. Click on . Position the cursor over C3, drag along the CO 
bond that you made in step 5 and release. Position the cursor 
over C5, drag along the CH bond that you made in step 6 and 
release. Repeat for the CH bonds at C9 and C14. Down wedges 
will appear for all four centers.

9. Click on  to clean up your drawing. Click on . The name 
androsterone should appear at the bottom right of the screen as 
the molecule is in the database. If it does not, you have made 
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an error somewhere. Select Edit Sketch from the Build menu 
or click on  if it appears at the top of the screen to return to 
the sketch pad.

10. Androsterone incorporates seven chiral centers. To assign them 
as R or S, select R/S Chirality from the Model menu or click on 

 if it appears at the top of the screen. R/S labels will appear 
next to each of the chiral centers.

11. Close androsterone.
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Tutorial 3
Building Organic Molecules 

The tutorials in this section introduce and illustrate tools to build 3D 
molecular structures. These include atomic fragments, functional 
groups and rings contained in the organic model kit together with tools 
for making and breaking bonds, deleting atoms and refining structure.

Organic Model Kit

The organic model kit contains a selection of atomic fragments 
corresponding to elements commonly found in organic molecules. 

Different hybridization states are included for some elements (C, N, 
O, and S) from top to bottom.
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 C(sp3) N(sp3) P(sp3) H
 C(sp2) N(sp2) O(sp3) F
 C(sp) N(sp) O(sp2) Cl
 C(aromatic) N(aromatic) S(sp3) Br
 Si(sp3) N(planar) S(sp2) I

A fragment is chosen by clicking on its icon, which is then displayed 
in a box at the top of the model kit. Once selected, the fragment may 
be used to initiate building, to add alongside of an existing structure or 
appended onto an existing structure. To initiate building, double click 
anywhere on screen. To add alongside of an existing structure, double 
click in a blank area on screen. To bond to an existing structure, click 
on a free valence (not an atom). Free valences are colored yellow 
on the selected molecule. Bond type in the case of atomic fragments 
with multiple bond types, for example, sp2 carbon, depends on the 
nature of the free valence selected.

Clicking on the Groups button near the bottom of the model kit 
changes the focus from fragments to groups, one of which will be 
shown in the box at the top of the model kit and named directly 
underneath. Clicking on the name brings up a menu of available 
groups.
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Once selected from the menu, a group may be used to initiate building, 
to add alongside of an existing structure on screen, or to add to an 
existing structure. 

Clicking on the Rings button near the bottom of the model kit changes 
the focus to rings, one of which will be shown in the box at the top 
of the model kit and named immediately underneath. Clicking on the 
name brings up a menu of available rings.

Once selected from the menu, a ring may be used to initiate building, 
to add alongside of an existing structure on screen, or to add to an 
existing structure.

Note that only hydrocarbon rings are available. Heteroatoms may be 
substituted for carbons, for example, substituting an oxygen for one 
of the carbons in cyclohexane leading to tetrahydropyran. Note also, 
that the amide and carboxylic acid/ester groups and the cyclohexane, 
cycloheptane, naphthalene, phenanthrene, indene and fluorene rings 
have more than one different free valence. The free valence that is 
to be used is marked with a gold • (in the icon shown in the box at 
the top of the model kit). The marked position circulates among the 
possible positions with repeated clicking on the icon. Selection of an 
axial or equatorial free valence in cyclohexane and cycloheptane is 
indicated by the label ax or eq appearing alongside the icon.
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Acrylonitrile

C C
H

H H

C
N

1. Click (left button) on the File menu and select (click on) New 
Build. Alternatively, click on  if it appears at the top of the 
screen. The organic model kit appears. Click on trigonal planar sp2 
hybridized carbon  from the fragment library. A model of 
the fragment appears at the top of the model kit. Bring the cursor 
anywhere on screen and double click (left button). To maintain 
compatibility with the sketch builder (see next tutorial), a double 
click is used to add the first fragment. This can be changed to 
single click (as in previous versions of Spartan Student) from 
the Settings tab in the Preferences dialog (Preferences under 
the Options menu). Rotate the carbon fragment (drag the mouse 
while holding down the left button) so that you can clearly see 
both the double free valence (=) and the two single free valences 
(–).

2. sp2 carbon is still selected. Click on the double free valence. The 
two fragments are connected by a double bond, leaving you with 
ethylene. The name ethylene will appear at the bottom right of 
the screen. If you make a mistake and click instead on the single 
free valence, select Undo from the Edit menu (or click on  
if it appears at the top of the screen). You can also start over by 
selecting Clear from the Edit menu (or click on  if it appears 
at the top of the screen).

3. Click on the Groups button at the bottom of the model kit, click 
on the name of whatever group is shown in the text box at the 
top of the model kit, and select Cyano from the groups available 
from the menu. Click on any of the four single free valences 
on ethylene (they are equivalent). This bonds the cyano group 
to ethylene, leaving you with acrylonitrile. Its name will now 
appear at the bottom right of the screen.
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4. Click on  at the bottom of the model kit. (You can also select 
Minimize from the Build menu or click on  if the icon appears 
at the top of the screen.) The molecular mechanics energy (36.2 
kJ/mol) and symmetry point group (Cs) are provided at the 
bottom right of the screen.

5. Select View from the Build menu (or click on the  icon at the 
top of the screen). The model kit disappears, leaving only a ball-
and-spoke model of acrylonitrile on screen. The name appears 
at the bottom of the screen as acrylonitrile is in the database.

 
ball-and-spoke model

 This model can be rotated, translated and zoomed by using the 
mouse in conjunction with keyboard functions. To rotate the 
model, drag the mouse while holding down the left button; to 
rotate in the plane of the screen also hold down the Shift key. 
To translate the model, drag the mouse with the right button 
depressed. To zoom the model (translation perpendicular to the 
screen), use the center mouse wheel (scroll wheel) if available, 
or hold down the Shift key in addition to the right button while 
dragging the mouse up (zoom in) or down (zoom out). 

Rotate the molecule by moving one finger over the screen. 
Rotate in the plane of the screen by twisting two fingers. 

Translate by moving two fingers. Zoom by pinching two fingers.

6. Select Close from the File menu or click on  at the top of the 
screen.
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Cyclohexanone
O

1. Click on the File menu and select New Build from the palette or 
click on  at the top of the screen. Click on the Rings button 
near the bottom of the model kit, click on the name of whatever 
ring is shown and select Cyclohexane from the menu. Double 
click anywhere on screen.

2. Select sp2 carbon  from the model kit. Double click on 
any carbon (not free valence). The sp3 hybridized carbon will 
be replaced by an sp2 hybridized carbon.

In the Organic Model Kit, fragment replacement is subject both to 
the usual valence rules and to the availability of free valences. For 
example, replacement of an sp3 carbon by an sp2 carbon requires 
that at least two free valences are available.

3. Select sp2 oxygen  from the model kit. Click on the double 
free valence on the sp2 carbon. You have made cyclohexanone. 
Click on  at the bottom of the model kit to produce a structure 
with Cs symmetry. Click on  to remove the model kit. The 
name cyclohexanone appears at the bottom of the screen as the 
molecule is in the database.

4. Close cyclohexanone.

Limonene

1

2 3 4

56

1. Select New Build from the File menu (or click on the  
icon at the top of the screen) to bring up the organic model 
kit. Click on the Rings button near the bottom of the model 
kit, click on the name of whatever ring is shown and select 
Cyclohexane from the menu. Double click anywhere on screen.
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2. Click on the Groups button near the bottom of the model kit, 
click on the name of whatever group is shown and select Alkenyl 
from the menu. Click on the equatorial free valence on C4 (see 
figure above for numbering). You have made vinylcyclohexane.

3. Click on the Make Bond icon ( ) at the bottom of the model 
kit. One after another click on the axial free valence on C1 and 
then the axial free valence on C2. You have made 4-vinyl-1-
cyclohexene.

4. Select sp3 carbon  from the model kit and one after another 
click on the free valence on C1 and on the free valence of the 
vinylic carbon attached to the ring. You have made limonene. 
Click on  at the bottom of the model kit to give a refined 
geometry and finally click on ( ) to remove the model kit. 
The name will appear at the bottom of the screen as limonene 
is in the database.

5. Close limonene.

Nicotine

N

N

Me

1. Select New Build from the File menu ( ). Click on the Rings 
button in the model kit. Click on the name of whatever ring 
is shown in the window at the top of the model kit and select 
Benzene from the menu. Double click anywhere on screen.

2. Click on the name Benzene (the currently selected ring) in the 
model kit and select Cyclopentane from the menu. Click on 
one of the free valences on benzene on screen. You have made 
phenylcyclopentane (the name will appear at the bottom of the 
screen).

3. Click on sp2 nitrogen in the model kit ( ) and double 
click on the appropriate (meta) carbon (not a free valence) in 
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the benzene ring for the structure on screen. You have made 
3-cyclopentylpyridine.

4. Click on sp3 nitrogen in the model kit ( ) and double 
click on the appropriate carbon in the cyclopentyl ring for the 
structure on screen. You have made nornicotine.

5. Click on sp3 carbon in the model kit ( ) and click on the 
free valence on the nitrogen in the pyrrolidine ring. Click on 

 at the bottom of the model kit to clean up your structure. 
The name nicotine will appear at the bottom of the screen as 
the molecule is in the database.

6. Click on the bond connecting the pyridine and pyrrolidine rings. 
A red arrow will encircle the bond and will also appear at the top 
of a narrow shaded band at the left of the screen. While holding 
down the left mouse button, move the cursor up or down inside 
this band to rotate about the bond.

Move one finger up and down on the bond to rotate about the 
bond.

7. Select R/S Chirality from the Model menu ( ). The R/S 
chirality will be displayed. The S isomer is the naturally 
occurring isomer of nicotine.

8. Close nicotine.
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Tutorial 4
Spectra, Properties and 

Graphical Models of Organic 
Molecules from the Database

The tutorials in this and the section that follows will utilize the 
molecules that you built and sketched in the preceeding two tutorials. 
The emphasis shifts from providing input, to analyzing the results 
of quantum chemical calculations (this tutorial) and to submitting 
calculations (the following tutorial).

The database supplied with Spartan Student provides atomic and 
molecular properties as well as NMR spectra that have previously 
been calculated using the wB97X-D/6-31G* or EDF2/6-31G* density 
functional model. Additionally, IR spectra from the EDF2/6-31G* is 
also accessible. The wave functions are available, allowing graphical 
models to be generated and displayed “on-the-fly”.

Limonene

1. Build limonene ( ), minimize ( ) and exit the builder ( ). 
Alternatively, sketch limonene ( ) and exit the sketcher ( ).

2. Click on the name limonene at the bottom of the screen and click 
on Replace in the dialog that results. Properties and spectra for 
limonene are now available.

3. Select Spectra from the Display menu, or click on  if it 
appears at the top of the screen. Click on  at the top of the 
spectra pane that results to show available calculated spectra (in 
red) and (possibly) available experimental spectra (in blue).
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 Select . The calculated 13C NMR spectrum appears in 

the spectra pane. Move the cursor horizontally over the spectrum. 
You will see that when you intersect a line, it will be highlighted 
in the spectrum and the value of the chemical shift indicated. 
Also, the carbon (or carbons) in the structure responsible for 
this line will be highlighted in the structure model (in the top 
part of the screen). You will see that there are ten lines in the 
calculated 13C spectrum, corresponding to the ten unique carbons 
in limonene.

4. Again, click on  at the top of the spectra pane, but this time, 
select . The experimental 13C spectrum of limonene 
will be superimposed on top of the calculated spectrum. Visual 
comparison will give you an idea of what you can expect from 
13C shift calculations. To get an even better idea, alter the 
range of the scale (initially from 150 to 0 ppm), by moving 
the cursor over the spectrum while holding down the the right 
button. You can also change the scale (initially from 150 ppm), 
that is, zoom-in or zoom-out, using the scroll wheel on your 
mouse. You can return to the original setting by clicking on  

  in the bar at the top of the spectra pane.

Move one finger over the spectrum to select a line. Move 
two fingers over the spectrum to shift the range of the scale 

and pinch two fingers to zoom in and out.

5. Close limonene.
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Indigo
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1. Build indigo ( ), minimize ( ) and exit the builder ( ). 
Alternatively, sketch indigo ( ) and exit the sketcher ( ).

2. Click on the name indigo at the bottom of the screen and make 
sure wB97X-D/6-31G* is selected and click on Replace in the 
dialog that results. Properties and spectra for indigo are now 
available. If the name does not appear, then you have made an 
error. In this case, re-enter either the builder by selecting Edit 
Build from the Build menu ( ), or the sketch pad by selecting 
Edit Sketch from the Build menu ( ) and correct your model.

3. The calculated proton NMR spectrum of indigo can be displayed 
in two ways. The simpler “idealized” presentation assumes that 
three-bond HH coupling constants are zero. Select Spectra 
from the Display menu ( ) to bring up the spectra pane. Click 
on  in the bar at the top to show available calculated spectra 
(in red) and possibly available experimental spectra (in blue). 
Select  from the palette. The spectrum that results 
shows only lines corresponding to the four unique hydrogens. 
To see the more familiar (and more complex) proton spectrum, 
click again on , but this time select . The same four 
lines appear, but all are split (as in a real proton spectrum). The 
lines at ≈ 6.72 and 7.88 ppm are doublets due to C7 and C4, 
respectively (and split by C6 and C5, respectively). The lines 
centering at ≈ 6.9 and 7.48 are quartets (doublet of doublets), 
due to C5 and C6, respectively (and split by C4 and C6 and C5 
and C7, respectively).

4. The experimental proton NMR for indigo is not available from 
the on-line database. However, the experimental 13C spectrum is 
available. You can if you wish compare it to the corresponding 
calculated spectrum. Either is accessed by clicking on  at the 
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top of the spectra pane followed by selecting the appropriate 
entry from the resulting palette.

5. Close indigo.

trans-Stilbene

1. Build trans-stilbene ( ), minimize ( ) and exit the builder 
( ). Alternatively, sketch trans-stilbene ( ) and exit the 
sketcher ( ).

2. Click on the name trans-stilbene at the bottom of the screen, 
make sure EDF2/6-31G* is selected and then click on Replace 
in the dialog that results. Data are now available.

3. Select Spectra from the Display menu ( ). Click on  in 
the bar at the top of the spectra pane and select . The 
calculated IR spectrum of trans-stilbene appears in the spectra 
pane. You may find it valuable to increase the size of the spectrum. 
Position the cursor inside the bar at the top of the spectra pane 
and drag it up.

4. Move the cursor horizontally over the spectrum. You will see 
that as you intersect a line in the spectrum, it will turn yellow 
and the value of the frequency will appear at the bottom. In 
addition, the molecular model “vibrates” to reflect the motion 
that the molecule undergoes. Examine the motions of one or 
more of the lines of moderate intensity in the vicinity of 1500 
cm-1 (at 1446, 1494 and 1609 cm-1). You might find it useful to 
expand the scale (use the scroll wheel) or to shift it (move the 
mouse horizontally over the spectrum while holding down the 
right button). You can return to the original settings by clicking 
on ( ) in the bar at the top of the spectra pane.
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Move one finger over the spectrum to select a line. Move 
two fingers over the spectrum to shift the range of the scale 

and pinch two fingers to zoom in and out.

5. Click on  from the bar at the top of the spectra pane and 
select . The experimental IR spectrum of trans-stilbene 
obtained from the public NIST database will be superimposed 
onto the calculated spectrum. Note that the two spectra are similar 
although the experimental spectrum exhibits a number of (small) 
lines not found in the calculated spectrum.

6. Close trans-stilbene.

Nicotine

N

N

1. Build nicotine ( ), minimize ( ) and exit the builder ( ). 
Alternatively, sketch nicotine ( ) and exit the sketcher ( ).

2. Click on the name nicotine at the bottom of the screen, and 
click on Replace in the dialog that results. Your structure will 
be replaced by that in the database making the wave function 
available.

3. Select Surfaces from either the Setup or Display menu or click 
on ( ) if it appears at the top of the screen. Click on Add 
(at the bottom of the Surfaces dialog that results) and select 
electrostatic potential map from the menu. This requests an 
electrostatic potential map (an electron density surface onto 
which the value of the electrostatic potential is mapped). A line 
electrostatic potential map appears at the top of the dialog.

 The graphics calculation will run automatically following your 
request. When it completes in a few seconds, check the box to 
the left of electrostatic potential map in the Surfaces dialog. 
The surface itself corresponds to the electron density, and 
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provides a measure of the overall size and shape of nicotine. 
The colors indicate values of the electrostatic potential on this 
surface. By convention, colors toward red correspond to negative 
potential (stabilizing interaction between the molecule and a 
positive charge), while colors toward blue correspond to positive 
potential. The two nitrogen atoms show the largest negative 
potential (red). Which is the more negative, the nitrogen in the 
pyridine ring or that in the pyrrolidine ring?

4. Quantify your observation. Select Properties from the Display 
menu or click on ( ) if it appears at the top of the screen and 
click anywhere on the electrostatic potential map. This will bring 
up the Surface Properties dialog.

 
 Check the box to the left of Legend to display the property range 

on screen. (Uncheck the box to remove the legend.) To translate 
the legend, click on the legend to select, then hold down the 
right mouse button and move the mouse. The legend is useful 
when making qualitative comparisons of property values. Turn 
the map such that you can clearly see the pyridine nitrogen and 
click on the area that is “most red”. An arrow marks the point on 
the surface and the value of the potential is shown to the right 
of the legend. Do the same for the pyrrolidine nitrogen.
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Tap on the legend to select. Move two fingers to move it 
around the screen. Pinch two fingers to make the legend 

smaller or larger.

5. Nicotine is very small and it is easy to associate regions on the 
map with the underlying molecular skeleton. This becomes more 
difficult with increasing molecular size. Change the presentation, 
from the Style menu located both inside the Surface Properties 
dialog and at the bottom right of the screen. Select Transparent 
or Mesh from this menu. You now can see through the map to 
the underlying molecular structure.

6. Close nicotine and any open dialogs.

N,N-Dimethylaniline

N

1. Build N,N-dimethylaniline ( ), minimize ( ) and exit the 
builder ( ). Alternatively, sketch N,N-dimethylaniline ( ) 
and exit the sketcher ( ).

2. Click on N,N-dimethylaniline at the bottom of the screen and 
click on Replace in the dialog that results. Your structure will 
be replaced by that in the database.

3. Select Surfaces from either the Setup or Display menu ( ). 
Click on Add at the bottom of the Surfaces dialog that results 
and select local ionization potential map from the menu. This 
requests a map showing the enegy required to remove an electron 
(the ionization potential) as a function of its location on the 
electron density surface. Calculation is automatic and will only 
take a few seconds. When completed, check the box to the left 
of local ionization potential map in the Surfaces dialog. Select 
Properties from the Display menu or click on ( ). Click on 
the local ionization potential map surface. Click on the Reset 
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M/M button. This puts the property range on an absolute scale 
which is useful when examining individual molecules. The 
color convention is the same as for the electrostatic potential 
map, although the scale is completely different. Local ionization 
potentials are always positive. Colors toward red correspond to 
small ionization potentials (greatest electrophilic reactivity) and 
colors toward blue correspond to large ionization potentials. Note 
that the red regions on the map are over the ortho and para ring 
positions. This is exactly what is experimentally observed.

4. Close N,N-dimethylaniline and any open dialogs.

Androsterone

H3C

H

HH

H
HO

H3C

O

1. Build androsterone ( ), minimize ( ) and exit the builder  
( ). It is much easier to sketch the molecule ( ) and exit the 
sketcher ( ).

2. Click on the name androsterone at the bottom right of the screen 
and click on Replace in the dialog that results. Your structure will 
be replaced by that in the database. If the (correct) name is not 
provided, then you have made a mistake. In this case, re-enter 
the builder by selecting Edit Sketch from the Build menu ( ).

3. Select Orbital Energies from the Display menu or click on  
 if it appears at the top of the screen. An orbital energy diagram 

will appear at the left of the screen. To examine the molecular 
orbital corresponding to a line in the diagram, click on the line. You 
will see that the LUMO is a π* orbital localized on the carbonyl 
group. It is clearly more concentrated on  carbon than on oxygen, 
but you cannot easily tell which side of the steroid skeleton 
(toward or away from the two methyl groups) it is concentrated. 
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For this, a LUMO map is a much better graphical model.

4. Select Surfaces from the Display menu ( ). Click on Add and 
select |LUMO| map from the menu. The graphics calculation 
will run automatically and will only require a few seconds. When 
completed, check the box to the left of |LUMO| map inside the 
Surfaces dialog. The largest (absolute) values of the LUMO 
are colored blue. Note that you can easily see that the LUMO is 
more concentrated on the face away from the methyl groups.

5. Close androsterone and any open dialogs.
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Tutorial 5
Spectra, Properties and 

Graphical Models of Organic 
Molecules from Quantum 

Chemical Calculations
The tutorials in this section provide the earliest, and some of the 
simplest examples, of specifying and performing quantum chemical 
calculations. As in the previous tutorial, they refer back to Tutorials 
2 and 3. 

2 min

Acrylonitrile

C C
H

H H

C
N

1. Build acrylonitrile ( ), minimize ( ) and exit the builder 
( ). Alternatively, sketch acrylonitrile ( ) and exit the 
sketcher ( ).

2. Select Calculations... from the Setup menu or click on  if 
it appears at the top of the screen, and perform the following 
operations in the Calculations dialog which appears.
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a. Select Equilibrium Geometry from the leftmost menu to the 
right of Calculate. This specifies optimization of equilibrium 
geometry.

b. Select wB97X-D/EDF2 and 6-31G* from the middle and 
rightmost menus to the right of Calculate. This requests that 
the wB97X-D/6-31G* density functional model is to be used 
for this calculation (the same model as that in the database).

c. Click on Submit at the bottom of the dialog. A file browser 
appears.

 
 Because the model is in the database (even though we will not use 

the data), the name acrylonitrile will be presented to you in the 
box to the right of File name:. Either use it or type in whatever 
name you like and then click on Save. You will be notified that 
the calculation has been submitted.



Tutorial 5 47

 
 The message will close automatically (after ≈5 seconds); you 

can also click on OK to remove the message from the screen.

After a molecule has been submitted, and until the calculation has 
completed, you are not permitted to modify any dialogs or other 
information associated with it.

3. You will be notified when the calculation has completed (less 
than a minute).

 
 Click on OK to remove the message from the screen. Select 

Output from the Display menu or click on  if it appears at 
the top of the screen. A window containing a summary of the 
calculation appears.

 
 Additional data is accessed by clicking on the Output tab. You 

can scan this by using the scroll bar at the right of the window 
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or by clicking (left button) on or inside the output window and 
using the scroll wheel on your mouse. Additional information 
includes the task, basis set, number of electrons, number of 
unpaired electrons and the charge, as well as further details of 
the calculation including the number of threads used during 
the calculation. Below this is the symmetry point group of the 
molecule that was maintained during the optimization.

 The lines under the heading Optimization tell the history of the 
optimization. If the geometry was not optimized satisfactorily 
an error message, such as: Optimization has exceeded N steps 
– Stop, will be displayed following the last optimization step 
and you would be notified that the job had failed.

 Near the end of the output is the final total energy (-170.764625 
atomic units for acrylonitrile with the wB97X-D/6-31G* 
model), and the computation time. Click on  at the top of the 
output dialog to close it.

 You may examine the total energy and dipole moment among 
other calculated properties without having to go through the 
output. Select Properties from the Display menu to bring up 
the Molecule Properties dialog.

  
 To see the dipole moment vector (indicating the sign and 

direction of the dipole moment), check the box to the right of 
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Display Dipole Vector. Wire, ball-and-wire or tube models are 
best for this display.

 
 Uncheck the box to remove the dipole moment vector.

 Click on an atom. The (Molecule Properties) dialog will be 
replaced by the Atom Properties dialog.

 
 Among other things, this provides atomic charges based on the 

electrostatic potential. To obtain the charge on another atom, 
simply click on it. Inspect all the atomic charges on acrylonitrile 
(by clicking on the appropriate atoms). When you are finished, 
click on  at the top of the Atom Properties dialog to close it.

4. Select Surfaces from either the Setup or Display menu ( ). 
Click on Add at the bottom of the Surfaces dialog that results, 
and select electrostatic potential map from the menu. This 
requests an electrostatic potential map (an electron density 
surface onto which the value of the electrostatic potential is 
mapped). The graphics calculation will run automatically 
(without needing to resubmit the job) following your request. 
When it completes in a few seconds, check the box to the left of 
electrostatic potential map in the Surfaces dialog. The surface 
itself corresponds to the electron density and provides a measure 
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of the overall size and shape of acrylonitrile. The colors indicate 
values of the electrostatic potential on this surface; by convention, 
colors toward red correspond to negative potential (stabilizing 
interaction between the molecule and a positive charge), while 
colors toward blue correspond to positive potential. The nitrogen 
(the most electronegative atom) is red and the hydrogens (the 
most electropositive atoms) are blue.

5. Close acrylonitrile and any open dialogs.

2 min

Cyclohexanone
O

1. Build cyclohexanone ( ), minimize ( ) and exit the builder 
( ). Alternatively, sketch cyclohexanone ( ) and exit the 
sketcher ( ).

2. Select Calculations... from the Setup menu or click on . 
Specify Equilibrium Geometry, wB97X-D and 6-31G* from 
the three menus to the right of Calculate. Click on Submit 
and accept the name cyclohexanone. Wait until the calculation 
completes (2-3 minutes) before proceeding to the next step.

3. Cyclohexanone undergoes nucleophilic attack at the carbonyl 
carbon, and it is reasonable to expect that the molecule’s lowest-
unoccupied molecular orbital (the LUMO) will be localized 
here. To visualize the LUMO, bring up the Surfaces dialog 
(Surfaces from the Setup or Display menu or click on ). 
Click on Add and select LUMO from the menu. Also request 
an electron density surface onto which the (absolute) value of 
the LUMO has been mapped in color (a so-called LUMO map). 
Click on Add and select |LUMO| map from the menu. The two 
graphics calculations will run automatically and will require 
only a few seconds.
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4. Check the box to the left of LUMO in the Surfaces dialog. 
You will see that the resulting graphic is a π* orbital primarily 
localized on the carbonyl group, consistent with the fact that 
nucleophiles (electron pairs) add to the carbonyl carbon. See if 
you can tell on which face of the carbonyl carbon is the LUMO 
more concentrated.

5. Uncheck the box to the left of LUMO in the Surfaces dialog (to 
turn off the display of the LUMO, it operates in toggle mode). 
Then check the box to the left of |LUMO| map to display the 
electron density surface onto which the (absolute) value of 
the LUMO has been mapped. By convention, colors toward 
red indicate small (absolute) values of the LUMO (near zero), 
while colors toward blue indicate large (absolute) values of the 
LUMO. We are looking for a “blue spot”. Note that it is directly 
over the carbonyl carbon. This corresponds to the maximum 
value of the LUMO and is where nucleophilic attack will occur.

6. You will see that the blue spot over the axial face of the carbonyl 
carbon is bigger (and more blue) than that over the equatorial 
face. This indicates preferential attack by nucleophiles onto the 
axial face. Quantify the difference by measuring the (absolute) 
value of the LUMO on these two faces. Select Properties from 
the Display menu or click on  and click anywhere on the 
graphic to bring up the Surface Properties dialog.
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 Check the box to the left of Legend to display the property range 
on screen. (Remove the checkmark to remove the legend.) To 
translate the legend, click on the legend to select, then hold 
down the right mouse button and move the mouse. The legend 
is useful when making qualitative comparisons of property 
values. Turn the map such that you can clearly see the axial 
face of the carbonyl carbon, and click on the area of maximum 
blue. The (absolute) value of the LUMO at the surface point 
you have selected is provided in the dialog to the right of Val. 
Note the value, and then turn the map over such that you can 
now see the equatorial face of the carbonyl carbon, and click 
on the region of maximum blue on this face. Do these values 
support your qualitative conclusions from viewing the image?

7. Close cyclohexanone and any open dialogs.

8 mins

3-Cyano-4-methylcyclohexenyl Radical
CH3

CN•

1. Build 3-cyano-4-methylcyclohexenyl radical ( ), minimize  
( ) and exit the builder ( ). Alternatively, sketch the radical 
( ) and exit the sketcher ( ).

2. Select Calculations... from the Setup menu ( ). Specify 
Equilibrium Geometry, Density Functional-Fock, wB97X-D,  
and 6-31G* from the menus to the right of Calculate. This 
molecule has one unpaired electron. If you sketched it (which 
requires that you explicitly specify the radical center) the number 
of unpaired electrons will be correct. However, if you built the 
molecule, you will need to change Unpaired Electrons from 0 
to 1. Click on Submit at the bottom of the Calculations dialog. 
Name it 3-cyano-4-methylcyclohexenyl radical. (A name will 
not be provided as the radical is not in the database.) Wait for 
the calculations to complete before proceeding.
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3. Select Surfaces from the Setup or Display menu or click on 
. Click on Add and select spin density from the menu. Click 

on Add and select spin density map from the menu. You have 
requested two different representations of spin distribution. The 
first presents spin density as a surface of constant value, while 
the second uses color to map the value of the spin density onto 
an electron density surface. Finally, request the singly-occupied 
molecular orbital. Click on Add one more time and select 
aHOMO (the highest-occupied molecular orbital of a spin that 
is, the orbital that contains the unpaired electron) from the menu.

4. The three graphics you requested will run automatically and 
will require only a few seconds to complete. When they are 
done, check the box to the left of spin density in the Surfaces 
dialog to display the spin density surface. Note that the spin 
density is delocalized over two of the ring carbons and onto the 
cyano group.

 
5. Remove the spin density surface (uncheck the box to the left 

of spin density in the Surfaces dialog) and then check the box 
to the left of spin density map to display a surface on which 
the spin density is mapped onto the electron density. Note that 
the areas of maximum spin (colored blue) closely match those 
where the surface is large in the previous image.

6. Remove the spin density map (uncheck the box to the left of 
spin density map), and then check the box to the left of aHOMO 
(the molecular orbital which holds the unpaired electron). Aside 
from the colors (different signs of the orbital), note that this 
graphic is nearly identical to the previously-displayed image of 
the spin.
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7. Uncheck the box to the left of aHOMO. Click on More 
Surfaces... at the bottom of the (Surfaces) dialog, and select 
Slice from the Surface menu and spin density from the 
Property menu. Click on OK. A new line Slice, spin appears 
in the window at the top of the dialog.* Select it by checking 
the box at the left. A plane (a slice of spin density) surrounded 
by a frame appears in the middle of the model on screen. Click 
inside the frame to select. The frame will turn gold. Position 
the cursor outside the frame, then press both the Shift key and 
right button and move the mouse up and down (or use the scroll 
wheel). This will zoom the plane. You can also translate and 
rotate the plane independently of the molecule using the usual 
mouse operations. Alternatively, you can move the molecule and 
plane together by first clicking on the molecule (the frame will 
now turn white) and then using the mouse. For all operations, 
be certain to keep the cursor positioned outside of the frame. 
Size and orient the slice as you wish.

 

Tap on the graphic to select the graphic and on the frame to 
select the frame. Use one finger to rotate and two fingers to 

translate the graphic or frame. Pinch two fingers to zoom the graphic 
or frame.

8. Remove 3-cyano-4-methylcyclohexenyl radical and any open 
dialogs.

* You can change the display style from Contours to Solid or Transparent using the Style 
menu at the bottom right of the screen. This will appear only when the slice is selected.
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Tutorial 6
Groups of Organic Molecules

The tutorials in this section introduce and illustrate a number of 
basic operations involved in processing groups of molecules, as well 
as the associated spreadsheet for organizing and fitting data and 
facilities for making plots.

Computational investigations typically involve series of related 
molecules. Here, it may be of interest to compare geometries, energies 
or other calculated properties, or to compare trends in calculated and 
measured properties. Spartan Student allows molecules to be grouped 
into a single document, either manually, or automatically as a result of 
following a particular vibrational motion, or from a scan of a dihedral 
angle. Once grouped, molecules may be aligned. Calculations may be 
performed either on individual molecules or on the complete group 
of molecules, and the results analyzed individually or altogether to 
seek out trends.

Associated with a multi-molecule document is a spreadsheet. This 
allows convenient access to virtually any calculated quantity that can 
be given a value. Additionally, data may be entered manually into 
the spreadsheet or pasted from other applications such as Excel. Data 
in the spreadsheet may be manipulated, linear regression analyses 
performed and plots displayed. Alternately, the data in a Spartan 
Student spreadsheet may be pasted into Excel (or other applications) 
for further analysis.

The tutorials in this section introduce and illustrate a number of 
basic group operations available in Spartan Student, building and 
manipulating multi-molecule documents, and fitting an experimental 
observable to one or more calculated properties by way of linear 
regression. The use of the Reactions dialog is illustrated. None of 
the examples in this tutorial actually require performing quantum 
chemical calculation as all molecules involved are in the database.
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Dienophiles in Diels-Alder Cycloadditions

The most common Diels-Alder reactions involve electron-rich dienes 
and electron-deficient dienophiles.

X

Y

X = R, OR

Y = CN, CHO, CO2H
X

Y

+

The rate of these reactions generally increases with increasing  
π-donor ability of the diene substituent, and with increasing  
π−acceptor ability of the dienophile substituent. This can be 
rationalized by noting that donor groups raise the energy of the 
highest-occupied molecular orbital (the HOMO) on the diene, while 
acceptor groups lower the energy of the lowest-unoccupied molecular 
orbital (the LUMO) on the dienophile. Thus, the HOMO-LUMO gap 
is reduced, leading to enhanced stabilization.

HOMO

LUMO

Orbital 
Energy

diene dienophile

better acceptor groups

better donor groups

The objective of this tutorial is to correlate experimental relative 
rates of Diels-Alder cycloadditions involving cyclopentadiene and a 
variety of cyanoethylenes with dienophile LUMO energies.

1. Build ( ) and minimize ( ) acrylonitrile, H2C=C(H)CN. 
Select View from the Build menu ( ). Copy the structure to 
the clipboard. Either right click on the background and choose 
Copy from the resulting contextual menu, or select Copy from 
the Edit menu ( ).

2. Select Build New Molecule (not New Build) from the File menu 
( ). This requests that a molecule that has yet to be built is 
to be appended onto the end of a group of molecules in which 
the currently selected molecule (acrylonitrile) is a member. 
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The screen will be cleared. Click on Clipboard at the bottom 
of the model kit and double click on screen. Acrylonitrile will 
appear. Click on Groups in the model kit, select Cyano and 
add to the appropriate free valence on acrylonitrile to make  
1,1-dicyanoethylene. Click on .

3. Repeat this procedure (Build New Molecule, followed by 
Clipboard, followed by Groups, followed by ) four more 
times to build cis and trans-1,2-dicyanoethylene, tricyanoethylene 
and tetracyanoethylene. When you are all done (six molecules in 
total in a single document), click on  to remove the model kit.

4. Click on the name of whatever molecule from the document 
appears at the bottom of the screen make sure that wB97X-D/ 
6-31G* is selected and click on Replace in the dialog that results, 
and then click on All. Your structures will be replaced by those 
from the database (all six are available).

5. Select Spreadsheet from the Display menu ( ).

 
 You can move among the six molecules either by clicking inside 

the “Label” cells at the far left of the spreadsheet, or by using 
the  and  (step) keys at the bottom left of the screen.

6. Enter experimental relative rates into the spreadsheet. 
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  log10   log10 
 dienophile (relative rate) dienophile (relative rate)
 acrylonitrile 0 1,1-dicyanoethylene 4.64
 trans-1,2-dicyanoethylene 1.89 tricyanoethylene 5.66
 cis-1,2-dicyanoethylene 1.94 tetracyanoethylene 7.61
 Experimental data from: J. Sauer, H. Weist and A. Mielert, Chem. Ber., 97, 3183 (1964).

 Double click inside the header cell for a blank column in the 
spreadsheet, type Log(rate)= and press the Enter key (return 
key on Mac). You need to press the Enter key (return key on 
Mac) following each entry (or use the  key). Sort by relative 
rate. Click on the column header Log(rate), and then click on 
Sort at the bottom of the spreadsheet.

7. Click inside a header cell for a blank column and click on Add... 
at the bottom of the spreadsheet. Alternatively, right click inside 
the header cell for a blank column in the spreadsheet, and select 
Add... from the contextual menu that results. Select E LUMO 
(eV) from the list in the dialog that results.

 
 The spreadsheet, which now contains both the calculated LUMO 

energies and experimental relative rates, has served its purpose. 
Remove it from the screen by clicking on  at the top.
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8. Select Plots... from the Display menu or click on  if it appears 
at the top of the screen. This leads to an empty plot pane at the 
right of the screen. Click on  in the bar at the top of the pane.

 Select Log(rate) from the list of items in the X Axis menu and 
E LUMO(eV) from the Y Axes list, and click on Create.

 
 Click on the Edit icon ( ), and then click to choose Least 

Squares Fit. Click Done when finished. A least-squares line 
will be drawn through the six data points.

9. Close the document and any open dialogs.
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Addition vs. Substitution

Alkenes normally undergo addition reactions whereas aromatic 
compounds normally undergo substitution reactions. For example, 
bromine reacts with cyclohexane to give trans-1,2-dibromocyclohexane 
(the addition product) not 1-bromocyclohexene, whereas it reacts with 
benzene to give bromobenzene (the substitution product) not trans-
5,6-dibromo-1,3-cyclohexadiene.

Br

Br Br
+ Br2 vs.

Br

Br Br
+ Br2 vs.

+  HBr

+  HBr

The objective of this tutorial is to establish the preferred product for 
each reaction.

1. One after another, build or sketch cyclohexene, trans-1,2-
dibromocyclohexane, 1-bromocyclohexene, benzene, trans-
5,6-dibromo-1,3-cyclohexadiene, bromobenzene, bromine 
(Br2) and hydrogen bromide (eight molecules in total). Put 
all in the same document. Use New Build ( ) or New 
Sketch ( ) for the first molecule and Build New Molecule  
( ) or Sketch New Molecule ( ) for each successive molecule.

2. Click on the name of whatever molecule from the document 
appears at the bottom of the screen, confirm wB97X-D/6-31G* 
is selected and click on Replace in the dialog that results and 
then click on All. Your structures will be replaced by those from 
the database (all eight are available).

3. Select Reactions from the Display menu or click on  if it 
appears at the top of the screen.
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 Choose Current Document from the menu to the right of 
Use. Compute the energy for Br2 addition to cyclohexene: 
select cyclohexene and bromine as Reactants and trans-1,2-
dibromocyclohexane (and <none>) as Products and click on 
the Compute button at the bottom center of the dialog. Repeat 
for the corresponding substitution energy (same reactants but 
the products are 1-bromocyclohexene and hydrogen bromide) 
and for both addition and substitution reactions of benzene 
(reactants are benzene and bromine and products are trans-5,6-
dibromomo-1-3-cyclohexadiene and <none> for addition and 
bromobenzene and hydrogen bromide for substitution).

 Are all reactions thermodynamically favorable (exothermic)? If 
any of the reactions are not exothermic, provide a rationale as 
to why they are not. Why is there a change in preferred reaction 
in moving from the alkene to the arene?

4. Close the document and any open dialogs. 
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Acidities of Carboxylic Acids

Acid strength is among the most important molecular properties. 
It is readily available from calculation, either in terms of absolute 
deprotonation energy,

AH A–  +  H+

or, more commonly, as the deprotonation energy relative to that of 
some standard acid (A°H).

AH  +  A°– A–  +  A°H

Electrostatic potential maps may offer an alternative to energy 
calculations for the description of relative acidities. In particular, 
the value of the electrostatic potential in the vicinity of the acidic 
hydrogen in the neutral acid might be expected to reveal gross trends 
in acidity. For example, the acidic hydrogen in a strong acid, such as 
nitric acid, is more positive than that in a weak acid, such as acetic 
acid, which in turn is more positive than that in a very weak acid, 
such as ethanol.

 ethanol acetic acid nitric acid

The objective of this tutorial is to use electrostatic potential maps 
to quantify changes in acid strength due to subtle variations in 
structure.

1. One after the other, build or sketch trichloroacetic, dichloroacetic, 
chloroacetic, formic, benzoic, acetic and pivalic acids. Put all 
molecules into the same document. Use New Build ( ) or New 
Sketch ( ) both from the File menu for the first molecule and 
use Build New Molecule ( ) or Sketch New Molecule ( ) 
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both from the File menu for each sucessive molecule. Click on 
 when you are done.

2. All of the molecules that you have built are available in the 
database. Click on the name of whichever molecule is selected at 
the bottom of the screen, click on Replace in the dialog that results 
and finally on All. The wave function is also provided as part of the 
database entry allowing electrostatic potential maps to be made.

3. Select Spreadsheet from the Display menu or click on . 
Expand it so that you can see all seven molecules, and that two 
data columns are available. Double click inside the header cell 
of the next available data column, type pKa and press the Enter 
key (return key on Mac). Enter the experimental pKa’s (given 
on the next page) into the appropriate cells under this column. 
You need to press the Enter (return) key following each entry. 
Alternatively, use the  key to move to the next cell.

 acid pKa acid pKa

 trichloroacetic (Cl3CCO2H) 0.7 benzoic (C6H5CO2H) 4.19
 dichloroacetic (Cl2CHCO2H) 1.48 acetic (CH3CO2H) 4.75
 chloroacetic (ClCH2CO2H) 2.85 pivalic ((CH3)3CCO2H) 5.03
 formic (HCO2H) 3.75  

 Experimental data from: E.P. Sargeant and B. Dempsey, Ionization Constants of Organic 
Acids in Aqueous Solution, IUPAC no. 23, Permagon Press, 1979.

4. Arrange the seven molecules on screen such that you can clearly 
see the acidic hydrogen on each. To display all molecules at once, 
check the box to the left of the molecule name (Label column) 
in the spreadsheet for each entry. To manipulate the molecules 
independently of one another, click to deselect Coupled from the 
Model menu or click on  if it appears at the top of the screen.

5. Select Surfaces from either the Setup or Display menus or click 
on  and then select electrostatic potential map. When the 
electrostatic potential map calculations complete (they will be 
marked “completed”), check the box at the left of electrostatic 
potential map in the Surfaces dialog. Select Properties from 
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the Display menu or click on  and click on the electrostatic 
potential map to display the Surface Properties dialog. Click 
on  to the right of Max inside the Surface Properties dialog. 
The maximum value of the electrostatic potential (corresponding 
to the acidic proton) will be pasted to the spreadsheet. Leave the 
dialog on screen.

6. Plot experimental pKa vs. maximum in the electrostatic potential. 
Select Plots from the Display menu or click on  and then 
select pKa under the X Axis menu and Property Max (Surface) 
from the Y Axes list. Click on Create. Click on Edit ( ). 
Choose Least Squares Fit and click on Done. Does there appear 
to be a correlation between pKa and the maximum value of the 
electrostatic potential?

7. Close the document and any remaining dialogs from the screen. 
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Tutorial 7
Spectra of Organic Molecules

This tutorial illustrates applications involving the calculation of IR 
and proton and 13C NMR spectra.

In addition to equilibrium geometries, reaction energies and diverse 
molecular properties, calculations are able to account for molecular 
spectra. The infrared spectrum arises from the transitions between 
ground and excited vibrational states, while the NMR spectrum arises 
from transitions between nuclear spin states. While experimental 
spectra are used to provide clues to the structure of an unknown 
molecule, that is, features in the spectrum are taken as evidence for 
features in the molecular structure, a calculated spectrum starts with a 
known structure. A high degree of similarity with a measured spectrum 
may be taken as evidence that the calculated molecule is the same or 
at least very similar to that for which a spectrum was measured. Lack 
of similarity suggests that the two molecules are not the same.

The first tutorial in this section deals with the infrared spectrum of 
methyl formate. It details the steps needed to calculate a spectrum 
and to relate the spectrum to the underlying molecular structure. The 
remaining three tutorials deal with NMR spectroscopy: detailing the 
steps involved in calculating and displaying the proton spectrum for 
1-methylindole and the 13C spectrum of cytisine, and examining the 
dependence of carbon chemical shifts on stereochemistry.

6 mins

Infrared Spectrum of Methyl Formate

In the harmonic approximation, the frequency at which a diatomic 
molecule vibrates is proportional to the square root of the ratio of 
the force constant (the second derivative of the energy with respect 
to change in bond length) and the reduced mass (the product of the 
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masses of the two atoms divided by their sum). This is in the infrared 
region of the electromagnetic spectrum. Frequency increases with 
increasing force constant or stiffness of the bond and decreases with 
increasing masses of the atoms involved in the bond.

frequency α force constant
reduced mass

The same expression applies for each of the 3N-6 vibrations of 
a polyatomic molecule with N atoms. Cartesian (or internal) 
coordinates need to be transformed to normal coordinates, a system 
that leads to a diagonal matrix of second energy derivatives. For a 
polyatomic molecule, these will typically involve the motions of 
several (and perhaps all) of the atoms.

The intensity of absorption for a diatomic molecule is proportional 
to the change in the dipole moment with change in bond length. The 
fact that there is no change in the dipole moment of a homonuclear 
diatomic molecule with change in bond length, means that molecules 
such as N2 and O2, which make up the bulk of the earth’s atmosphere,  
are transparent in the infrared. The intensity of each of the individual 
lines in an infrared spectrum of a polyatomic molecule follows 
from the change in dipole moment along the associated normal 
coordinate. Note that some of the normal coordinates in a polyatomic 
molecule may not lead to a change in dipole moment, for example, 
the symmetric stretch in carbon dioxide where both CO bonds are 
simultaneously moved. 

This tutorial illustrates the steps required to calculate and display an 
infrared spectrum and to compare it with an experimental spectrum. 
It illustrates how the ease or difficulty of molecular motion and 
atomic masses affect frequency.

1. Build methyl formate and click on . Select Calculations... 
from the Setup menu ( ), and request an equilibrium geometry 
using the EDF2/6-31G* density functional model. Check IR and 
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click on Submit. Accept the name.*

2. After the calculation has completed (several minutes), select 
Spectra from the Display menu ( ). Click on the  in the 
bar at the top of the spectra pane and select  from the 
palette of icons. Click on the  again and select  from 
the icon palette. Calculated (in red) and experimental (in blue) 
infrared spectra are now superimposed.

 
3. Move the mouse while holding down the right button to shift the 

cursor across the spectrum. Position it over the intense line in 
the (calculated) spectrum at 1774 cm-1. Note that the molecular 
model (on screen above the spectra pane) vibrates. Describe the 
motion. Position it over the intense line at 1211 cm-1 and describe 
its motion.

4. Select Save As from the File menu ( ) to make a copy of 
methyl formate; name it methyl formate d3. Select Properties 
from the Display menu or click on  and click on one of the 
three hydrogen atoms on the methyl group to bring up the Atom 
Properties dialog. Change Mass Number from Standard to 2 
Deuterium. Repeat for the other two methyl group hydrogen 
atoms. Resubmit the calculation (it will require only a few 
seconds) by selecting Submit ( ) from the Setup menu. 
Compare the frequencies of the undeuterated and deuterated 
forms of methyl formate, and identify which change the most 
and which change the least. Explain your results.

5. Close all molecules and dialogs that are open on screen.

* Methyl formate is in the database and you can, if you like, avoid doing any calculations and 
simply retreive it. In this case, click on the name at the bottom of the screen and then click 
on Replace in the dialog that results.
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 6 mins

Proton NMR Spectrum of 1-Methylindole

Proton NMR spectroscopy was the first tool available to chemists that 
allowed definitive assignment of the molecular structures of complex 
organic molecules. By the 1970’s, it had largely replaced infrared 
spectroscopy and to a large extent chemical proofs of structure. 13C 
NMR is now more dominant, but proton NMR remains an essential 
tool in the chemist’s arsenal.

NMR is based on the fact that nuclei possess spins that can either 
align parallel or antiparallel to an applied magnetic field, giving rise 
to different nuclear spin states. The relative energy of these states 
(ΔE) depends on the nucleus and on the strength of the applied 
magnetic field, by way of a simple relationship.

∆E = γℏB0

γ is the gyromagnetic ratio (a constant for a given type of nucleus), 
ℏ is Planck’s constant divided by 2π and B0 is the strength of the 
magnetic field at the nucleus. While the two nuclear spin states are 
normally in equilibrium, this equilibrium can be upset by applying a 
second magnetic field. The absorption of energy as a function of field 
strength (a resonance) between the states can then be detected. 
The key to the utility of the magnetic resonance experiment is that 
the energy at which a nucleus resonates depends on its location in the 
molecule, and is different for each (chemically) distinct nucleus. The 
reason  is that the applied magnetic field is weakened by electrons 
around the nucleus. Nuclei that are well shielded by the electron 
cloud will feel a lesser magnetic field than those that are poorly 
shielded, and will show a smaller energy splitting. The difference, 
given relative to a standard, is termed a chemical shift. By convention, 
both proton and 13C chemical shifts (treated later in this tutorial) 
are reported relative to tetramethylsilane (TMS) as a standard.

While each unique proton in a molecule gives rise to a single line 
(resonance) in the spectrum, the spins on nearby nuclei add and 
subtract to the external magnetic field. This leads to a splitting of 
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lines, the splitting pattern depending on the number of neighboring 
protons and their geometry. Discounting splitting, the intensity of 
the lines is approximately proportional to the number of equivalent 
protons that contribute. For example, the proton NMR spectrum of 
1-methylindole would be expected to show seven lines, six with unit 
intensity corresponding to the protons on the indole ring and one line 
with three times the intensity corresponding to the three equivalent 
methyl group protons.

The objective of this tutorial is to calculate the proton NMR spectrum 
of 1-methylindole and compare it with the experimental proton 
spectrum in the absence of three-bond HH coupling. 

1. Build or sketch 1-methylindole. If you build, click on  and then 
on . If you sketch, click on . Select Calculations... from the 
Setup menu or click on . Specify calculation of equilibrium 
geometry using the wB97X-D/6-31G* density functional 
model. Check NMR and click on Submit. Accept the name 
1-methylindole. The calculation will require several minutes.*

2. When the calculation has completed (or after you have retreived 
results from the database), select Spectra from the Display menu  
or click on . Click on  in the bar at the top of the spectra 
pane and select  (proton NMR spectrum in which there 
is no HH coupling).

 

* 1-methylindole is in the database and you can, if you like, avoid doing any calculations and 
simply retrieve it. In this case, click on the name at the bottom of the screen and then click 
on Replace in the dialog that results.
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 Move the mouse while holding down the left button over the 
spectrum. When you intersect a line, a numerical value for the 
proton shift appears at the top of the spectrum.

3. Click again on  and this time select  (experimental 
proton NMR spectrum with HH coupling constants set to 0). The 
experimental spectrum will be retrieved from the public NMR 
database and displayed on top of the calculated spectrum. Proton-
proton coupling has been eliminated (all coupling constants are 
assumed to be 0).

 

 The comparison gives you an idea of the level of agreement that 
can be expected between calculated and experimental proton 
spectra. 

4. Click again on   and select  (calculated proton NMR 
spectrum). The calculated proton spectrum that now appears 
accounts for three-bond HH coupling. Note that coupling 
constants not calculated but rather evaluated empirically based 
on the three-dimensional geometry of the molecule.

 

 You can focus in on details by a combination of zooming the 
spectrum (scroll wheel) and shifting the displayed range (move 
the mouse while holding down both the right button and Shift 
key). You will see that lines due to protons at C2, C3, C4 and C7 
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are doublets, while those due to protons at C5 and C6 are quartets 
(doublet of doublets).

5. Close 1-methylindole and any remaining dialogs.

 20 mins

13C Spectrum of Cytisine

There are several reasons why NMR spectroscopy, in particular, 13C 
NMR, is one of the most important routine analytical techniques 
available for characterizing organic molecules. The experiment, 
which is straightforward and can be carried out rapidly, requires 
relatively small samples and is non-destructive. The resulting (proton 
decoupled) spectrum is quite simple, comprising but a single line for 
each and every unique carbon. However, assigning 13C spectra is by 
no means trivial, even for molecules that might appear to be quite 
simple. The problem is that the positions of the lines in the spectrum 
(the chemical shifts) are very sensitive to the  environment in which 
the carbons find themselves. Where two or more carbons in a molecule 
reside in what appears to be similar environments, it may be very 
difficult to distinguish them. 

This tutorial uses the alkaloid cytisine to illustrate the use of 
calculated 13C spectra to assist in assigning the measured spectrum 
of the molecule.

N
O

NH

1. Either build and minimize or sketch caulophylline and click on 
. Select Calculations... from the Setup menu or click on  
 and specify calculation of equilibrium geometry with the 

wB97X-D/6-31G* density functional model. Check NMR, click 
on Submit and accept the name cytisine. The job will require 
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upwards of 15 minutes to complete*.

2. When the calculation is done (or after you have accessed 
information from the database), select Spectra from the Display 
menu or click on . Click on  in the bar at the top of the 
spectra pane and select  (experimental 13C spectrum). 
The experimental 13C spectrum is drawn.

 
3. Use the calculated spectrum to associate the individual lines 

in the experimental 13C spectrum with specific carbons in the 
structure of caulophylline. Click on  and this time select 

 (calculated 13C spectrum). The calculated spectrum (in 
red) will be superimposed on top of the experimental spectrum 
(in blue). This gives an impression of the performance of the 
quantum chemical calculations. It also allows you to assign the 
lines in the (calculated) spectrum to individual carbons and by 
inference to assign the lines in the experimental spectrum. Move 
the mouse while holding down the left button over the spectrum. 
When the cursor overlaps a line in the spectrum, the value of the 
chemical shift will be shown, and the carbons responsible will 
be highlighted in the structure model.

4. Close cytisine and any open dialogs.

* Cytisine is available in the database. If you decide to use this instead of doing the 
calculations, click on the name at the bottom of the screen and click on Replace at the 
bottom of the dialog that results. 
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no calculations

Stereochemical Assignments from 13C Spectra

NMR spectroscopy, in particular 13C spectroscopy, is without doubt 
the method of choice to establish the three-dimensional structure of 
organic molecules. Only X-ray diffraction provides more definitive 
results, although the requirement of a crystalline sample severely limits 
its application. The availability of a “virtual NMR spectrometer” offers 
organic chemists an entirely new paradigm for structure determination, 
that is direct comparison of a measured spectrum with calculated 
spectra for one or more chemically reasonable candidates.

The objective of this tutorial is to compare calculated 13C chemical 
shifts for endo and exo stereoisomers of 2-methylnorbornane with 
the corresponding experimental shifts. The question to be answered 
is whether or not the calculations are able to reproduce differences 
in chemical shifts as a function of stereochemistry.

1. Build or sketch endo and exo stereoisomers of 2-methylnorbornane.

 
 Place both in the same document. Use Build New Molecule  

( ) or Sketch New Molecule ( ) from the File menu (instead 
of New Build or New Sketch) for the second stereoisomer.

2. Both stereoisomers are available in the database so there is no 
need to perform any calculations. Click on the name of whichever 
molecule is selected at the bottom of the screen. Confirm that 
wB97X-D/6-31G* is selected and click on Replace in the dialog 
that results and then on All.

3. Select Spectra from the Display menu or click on , click on 
 in the bar at the top of the spectra pane and select . 

You can switch between the two stereoisomers using the  and 
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CH3

4

1 2

35

6

7

 keys at the bottom of the screen. Compare the 13C chemical 
shifts with experimental values, paying particular attention to 
differences between endo and exo stereoisomers.

  Experimental 13C NMR Data  endo exo ∆
  C1 43.5 42.2 -1.3
  C2 36.8 34.6 -2.2
  C3 40.2 40.7 0.5
  C4 37.3 38.2 0.9
  C5 30.3 30.6 0.3
  C6 29.0 22.4 -6.6
  C7 35.0 38.9 3.9
  CH3 22.3 17.4 -4.9

 Can the calculations be used to distinguish between the two 
isomers?

4. Close the document and any open dialogs.
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Tutorial 8
Flexible Molecules

This tutorial describes issues associated with calculations on flexible 
molecules.  

The three tutorials in this section illustrate applications involving 
molecules with more than one stable conformer, that is, molecules that 
incorporate rotatable single bonds or flexible rings. The first tutorial 
deals with a molecule with only one degree of (conformational) freedom. 
The goal here is not only to identify the “best” conformer, but also to 
rationalize why it is the best. The second tutorial deals with a molecule 
with multiple degrees of freedom and multiple conformers. The goal 
here is to identify the best (lowest energy) conformer. The final tutorial 
involves a molecule with several degrees of conformational freedom. 
Its goal is to obtain the lowest energy conformers that contribute to 
the molecule’s Boltzmann distribution (with molecular mechanics), 
and then to calculate the NMR spectrum for these conformers and 
compare the calculated 13C NMR to a known experimental NMR. 

8 mins

Internal Rotation in Dimethylperoxide

OO
CH3

CH3

Any function chosen to represent the energy of rotation about a single 
bond needs to repeat itself in 360°. The most common choice is a 
truncated Fourier series.

Etorsion (ω)  =  ktorsion1 (1 - cos(ω - ωeq))  + ktorsion2 (1 - cos2(ω - ωeq))
+  ktorsion3 (1 - cos3(ω - ωeq))

Here, ωe q is the ideal dihedral angle and ktorsion1, k torsion2 and ktorsion3 are 
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parameters. The three terms are independent and may be independently 
interpreted. The first (one-fold) term accounts for the difference in 
energy between syn and anti conformers, the second (two-fold) 
term for the difference in energy between planar and perpendicular 
conformers, and the third (three-fold) term for the difference in energy 
between eclipsed and staggered conformers. 

The objective of this tutorial is to interpret the potential energy function 
for rotation about the oxygen-oxygen bond in dimethylperoxide.

1. Build dimethylperoxide. If the molecule is not already in an anti 
conformation, select Measure Dihedral from the Geometry 
menu ( ) and set the COOC dihedral angle to 180 (180°) by 
typing 180 in the box at the lower right of the screen and pressing 
the Enter key (return key on Mac). Do not minimize.

2. Select Constrain Dihedral from the Geometry menu ( ). 
Select the COOC torsion, and then click on  at the bottom 
right of the screen. The icon will change to  indicating that a 
dihedral constraint is to be applied. 

 Check the box to the left of Profile at the bottom right of the 
screen. This will result in two additional text boxes.

 
 Leave 180 (180°) in the original (leftmost) box alone, but change 

the contents of the box to the right of to to 0 (0°). You need to 
press the Enter (return) key after you type in the value. Steps 
should be 10. If it is not, type 10 and press the Enter (return) 
key. What you have specified is that the dihedral angle will be 
constrained first to 180°, then to 160°*, then to 140°, etc. and 
finally to 0°. Click on . 

4. Select Calculations... from the Setup menu ( ) and specify 
Energy Profile, Hartree-Fock and 6-31G* from the menus to 
the right of Calculate. Click on Submit and accept the name 
dimethyl peroxide.

* The difference between constraint values is given by: (final-initial)/(steps-1).
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5. When the calculations complete, the results are written to a new 
document named dimethyl peroxide.Prof.spartan. Click on Yes 
following the prompt that will ask you if you want to open this 
file. Align the conformers. Select Align from the Geometry 
menu ( ), one after the other, click on both oxygens and on 
one of the carbons, and finally click on the Align button at 
the bottom right of the screen. Select Spreadsheet from the 
Display menu ( ), and enter both the energies relative to 
the 180° conformer, and the COOC dihedral angles. First click 
on the label (M0001) for the top entry in the spreadsheet (the 
180° conformer), then click on the header cell for the leftmost 
blank column, and finally, click on Add at the bottom of the 
spreadsheet. Select rel. E from the quantities under the Molecule 
List tab, kJ/mol from the Relative Energy Units menu. To 
enter the dihedral angle constraints, select Constrain Dihedral 
from the Geometry menu ( ), click on the constraint marker 
attached to dimethylperoxide and click on  at the bottom of 
the screen (to the right of the value of the dihedral angle). Click 
on .

6. Select Plots from the Display menu ( ). Click on  
at the top of the (empty) plot pane and select  Constraint(Con1) 
from the X Axis menu and Relative Energy (kJ/mol) from the 
Y Axes list; click on the Create button.
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 By default, the data points are not connected. To fit the points to 
a Fourier series, click on  at the top of the plot pane and select 
Fourier to the right of Curve in the resulting dialog. Check the 
box to the left of Curve and click the Done button.

 

7. Use energies from B3LYP/6-31G* density functional 
calculations, together with the Hartree-Fock geometries  
to provide a better fitting function. First, make a copy  
of dimethyl peroxide.Prof.spartan. Name it dimethyl peroxide 
density functional. Select Calculations... from the Setup menu 
( ) and select Energy, ωB97X-D and 6-31G* from the three 
menus to the right of Calculate. Make certain that Global 
Calculations (at the bottom of the dialog) is checked to signify 
that energy calculations are to be performed on all conformers. 
Click on Submit.

8. Energy calculations for all ten confromers will require a few 
minutes to complete. When they are done, examine the plot and 
compare it to the energy plot produced earlier.

9. Remove all molecules and dialogs from the screen. 
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15 mins

Ethinamate

O
O

NH2

Ethinamate, a prescription drug previously used for the treatment 
of insomnia, provides a very simple example of a molecule with 
multiple conformers. These arise from rotation about the CO single 
bond connecting the carbamate group and the cyclohexane ring and 
the “flipping” of the ring. Rotation about the other CO single bond 
can be ignored as the “cis” conformer drawn above is much lower in 
energy than the “trans” alternative.  

1. Build or sketch ethinamate. Click on . Select Calculations... 
from the Setup menu ( ) and specify Conformer Distribution 
from the menu to the right of Calculate. MMFF molecular 
mechanics is the only model available in Spartan Student. Click 
on Submit, and accept the name ethinamate.

2. When the job completes (a few seconds), all low-energy 
conformers will be placed in a new document ethinamate.Conf.
spartan. Click on OK to the request to open this document. 
Select Spreadsheet from the Display menu ( ), and size 
the spreadsheet such that all rows (corresponding to different 
conformers) are visible. Click on the top row of the spreadsheet 
(corresponding to the lowest-energy conformer according 
to the MMFF model). Click on Add at the bottom of the 
spreadsheet. Select Relative Energy and Boltzmann Weights 
from the Molecule List tabs, kJ/mol from the Relative Energy 
Units menu. Describe the lowest-energy conformer. Does the 
carbamate group prefer to be equatorial or axial? Does one 
conformer dominate the Boltzmann distribution or are two or 
more conformers needed to account for 90%? Have you found the 
expected number of conformers? If not, describe any “missing” 
conformers and suggest why they are missing.
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3. See if the results of the molecular mechanics calculations 
(identity of the lowest-energy conformer and makeup of the 
Boltzmann distribution) maintain if you move to a better 
theoretical model.

 Make a copy of ethinamate.Conf.spartan (Save As from the 
File menu or click on ). Name it ethinamate conformers 
density functional. Select Calculations... from the Setup menu 
( ) with this copy and specify calculation of Equilibrium 
Geometry using the B3LYP/6-31G* density functional model. 
Make certain that Global Calculations at the bottom of the 
dialog is checked. (This applies the calculation model to all the 
molecules in the document and not just the selected molecule.) 
Click on Submit.

4. The calculations may require at least 10-20 minutes or more 
(depending on your computer). When completed, bring up the 
spreadsheet and identify the best conformer. Is it the same as that 
assigned from the MMFF calculations? If not, is the equatorial 
or axial preference for the carbamate group the same? Is the 
Boltzmann distribution similar in the sense that one conformer 
dominates or two or more conformers contribute significantly.

5. Close any open documents and dialogs.

15 mins

13C Chemical Shifts Depend on Conformation

At normal temperatures, the time for nuclear spin relaxation is very 
long relative to time required for equilibration among conformers. 
This means that for each of the carbon chemical shifts in the NMR 
spectrum of a flexible molecule, 13C, will be a weighted  average of 
the shifts NMR of the individual conformers,13Ci.

13C = Σi ωi
13Ci

The weight, ωi, is given by the Boltzmann equation, and depends on 
its energy, εi (relative to that of the lowest-energy conformer, ε0) and 
on temperature, T. Summation is over all conformers (including the 
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lowest-energy conformer), gi is the number of times that conformer i 
appears in the overall distribution and k is the Boltzmann constant.

ωi = gi exp - [εi - ε0/kT]/Σj {exp - [εj - ε0/kT]}
In practice, conformers that are 10 kJ/mol or more above the lowest-
energy conformer make a negligible contribution to the total (at 
room temperature). However, molecular mechanics is not capable 
of supplying conformer energies within such a tight threshold and 
looser limits (involving more conformers) are needed for preliminary 
steps in a calculation of Boltzmann weights.

In this tutorial, you will see how well the 13C spectrum of the “best” 
(lowest-energy) conformer of limonene reproduces the experimental 
room temperature NMR. More generally, you will assess the sensitivity 
of 13C chemical shifts to change in conformation.

1. Build or sketch limonene. Click on .

 
2. Select Calculations... from the Setup menu ( ) and request a 

Conformer Distribution using the MMFF molecular mechanics 
model. Click on Submit and accept the name limonene.

3. The job will complete in a few seconds and you will be asked 
whether or not you wish to open limonene.Conf.M0001, the 
document containing the full list of conformers. Click on OK. 
Select Spreadsheet from the Display menu ( ) with this list. 
Click on the top row of the spreadsheet to select the lowest energy 
conformer. Click on Add at the bottom of the spreadsheet, click 
on the Molecule List tab, select both rel. E and Boltzmann 
Weights and click anywhere on screen to dismiss the dialog.

4. Delete any conformers that are more than 40 kJ/mol higher 
in energy than the best conformer, as they will not contribute 
significantly to the Boltzmann distribution.
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5. Select Calculations... from the Setup menu and specify an 
Energy calculation and Density Functional and ωB97X-D with 
the 6-31G* basis set. We are simplifying the calculations by 
using MMFF geometries, but several conformers are involved 
and it will require several minutes. Check NMR to the right of 
Calculate and confirm Current Model is selected to the right 
of NMR. Click on Submit.

6. When the calculation completes, select Spectra from Display 
menu ( ), click on  in the bar at the top of the spectra pane 
and select . Click again on  and this time select the 
experimental 13C spectrum  for each of the low-energy 
conformers. You can move from one conformer to another using 
the “step keys” (  and ) at the bottom left of the screen. While 
the calculated spectrum changes from one conformer to another, 
there is only one experimental spectrum. Is there significant 
variation as you move from one conformer to another? Does 
the spectrum from the lowest-energy conformer adequately 
reproduce the experimental spectrum? 

4. Close any open documents and dialogs.
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Tutorial 9
Organic Reactions

This tutorial outlines and illustrates strategies for locating and 
verifying transition states for organic reactions.

While unique valence structures may generally be written for 
most molecules and, based on these structures, reasonable guesses 
at bond lengths and angles may be made, it is often difficult to 
designate appropriate valence structures for transition states, let alone 
specify detailed geometries. The reason is the complete absence of 
experimental data for the structures of transition states. However, 
calculated transition-state geometries are now commonplace, and 
Spartan Student provides both a library of calculated transition-state 
geometries and a facility for automatically matching an entry in this 
library with the reaction at hand.*

Spartan Student also provides a procedure for driving user-
defined coordinates. Aside from conformational analysis (see 
discussion in Tutorial 8), the major application of this is to force 
reactions, thereby permitting identification of transition states.

The first tutorial in this section illustrates Spartan Student’s automatic 
procedure for guessing transition-state geometries, and the use of 
vibrational analysis to verify that a particular structure corresponds 
to a transition state and to show the motion connecting it to reactants 
and products. The second tutorial illustrates how a reaction may be 
driven through a transition state.

An example of a transition state calculation for an organometallic 
reaction is provided in Tutorial 11 Inorganic and Organometallic 
Molecules.

* Where a reaction is unknown to Spartan Student’s transition state library, a fallback 
technique which averages reactant and product geometries (similar to the so-called linear 
synchronous transit method) is invoked.
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10 mins

Ene Reaction of 1-Pentene
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The proposed mechanism of the ene reaction involves simultaneous 
transfer of a hydrogen atom and CC bond cleavage. The objective 
of this tutorial is to establish the transition state for the ene reaction 
of 1-pentene and to examine the reaction coordinate for evidence of 
concerted motion.

1. Build 1-pentene in a conformation in which one of the terminal 
hydrogens on the ethyl group is poised to transfer to the terminal 
methylene group. To rotate about a (single) bond, first click 
on it to select (it will be marked by a red arrow), and drag the 
mouse up or down in the area below  at the left of the screen. 
Alternatively, hold down the left button and Alt key (option key 
on Mac) and move the mouse up and down. Minimize and click 
on .

2. Select Transition State from the Build menu or click on  if 
it appears at the top of the screen. Click on bond a in the figure 
on the following page and then click on bond b. A curved arrow 
from double bond a to single bond b will be drawn.

 

C

C
C

C

C

HH
H

H H

HHHH H

a

bc

d

e

 Next, click on bond c and then on bond d. A second curved arrow 
from bonds c to d will be drawn. Finally, click on bond e and 
then, click on the (methyl) hydrogen to be transferred and next 
on the terminal (methylene) carbon to receive this hydrogen. 



Tutorial 9 85

A third curved arrow from bond e to the center of a dotted line 
that has been drawn between the hydrogen and oxygen, will 
appear.

 If you make a mistake, you can remove an arrow by selecting 
Delete from the Build menu ( ) and then clicking on the arrow. 
(You will need to select  to continue.) Alternatively, hold down 
the Delete key as you click on an arrow. With all three arrows in 
place, click on  (Search Transition State) at the bottom right 
of the screen. Your structure will be replaced by a guess at the 
ene transition state. If the resulting structure is unreasonable, 
then you have probably made an error in the placement of the 
arrows. In this case, select Undo from the Edit menu ( ) to 
return to the model with the arrows and modify accordingly.

3. Select Calculations... from the Setup menu ( ), and specify 
calculation of transition-state geometry using the 3-21G Hartree-
Fock model. Select Transition State Geometry, Hartree-Fock and  
3-21G from the three menus to the right of Calculate. Check IR. 
This will allow you to confirm that you have found a transition 
state, and that it smoothly connects reactant and product. Click 
on Submit and name it ene reaction 1-pentene.

4. When the job completes, animate the motion of atoms along the 
reaction coordinate. Select Spectra from the Display menu ( ), 
click on  in the bar at the top of the spectra pane and click 
on  in the palette that results. Click on  (Tables) at the left 
of the spectra pane to bring up a list of frequencies and intensities. 

 

 Click the top entry in the list. It corresponds to an imaginary 
frequency, and will be designated with an i in front of the number. 
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As detailed in Tutorial 7 of the Spartan Student Manual, vibrational 
frequency is proportional to the square root of the ratio of the force 
constant (reflecting the curvature of the potential surface along a 
particular coordinate) divided by a combination of the masses of 
atoms involved in motion along that coordinate. At a transition 
state (a maximum in the reaction coordinate), the curvature is 
negative. Since the mass term is positive, the quantity inside the 
square root is negative and the frequency is an imaginary number.

 Is the vibrational motion consistent with an ene reaction of 
interest and not with some other process? 

5. Click on  (Make List) at the left of the spectra pane. Controls 
in the dialog that result allow for changing both the amplitude of 
vibration (Amp) and the number of steps that make up the motion 
(Steps). Leave the number of steps (11) alone but change the 
amplitude to 0.3. Type 0.3 in the box to the right of Amplitude: 
and press the Enter key (return key on Mac). Next, click on 
Make List at the bottom of the dialog. This will give rise to a 
new document containing 11 structures that follow the reaction 
coordinate down from the transition state both toward reactant and 
product. You are done with ene reaction 1-pentene, so close it.

6. With focus on the new document, select Calculations... from 
the Setup menu ( ) and specify Energy, Hartree-Fock and 
3-21G from the three menus to the right of Calculate (the 
same as used to obtain the transition state and calculate the 
frequencies). Make certain that Global Calculations is checked. 
Select Surfaces from either the Setup or Display menu ( ) 
and specify evaluation of two surfaces: a bond density surface 
and a bond density surface onto which the electrostatic potential 
has been mapped. Before you do so, make certain that Global 
Surfaces is checked. Click on More Surfaces...*, select density 
(bond) for Surface and none for Property and click on Apply. 
Select density (bond) for surface and potential for Property 
and click on OK.

* You need to use More Surfaces rather than Add as the electrostatic potential is mapped on 
the bond density surface.
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7. Submit for calculation*. Name it ene reaction 1-pentene  
sequence. Once the job has completed, enter the Surfaces 
dialog and examine the surfaces that you have calculated. For 
each, step through the sequence of structures (  and ) keys at 
the bottom of the screen) or animate the reaction ( ). Note, in 
particular, the changes in bonding revealed by the bond density 
surface. Also pay attention to the value of the potential on the 
migrating atom. This reflects its charge. Is it best described as a 
proton (blue), hydrogen atom (green) or hydride anion (red)? 

8. Close all open documents and dialogs.

10 mins

SN2 Reaction of Bromide and Methyl Chloride

Br–  + C Cl
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H
+  Cl–CBr
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H H

ClBr

1. The SN2 reaction passes through a transition state in which 
carbon is in a trigonal bipyramid geometry and the entering and 
leaving groups are colinear. To build it, first construct methyl 
chloride. Then select bromine from the palette of icons in the 
model kit. Hold down the Insert key (option key on Mac) and 
click on screen opposite chlorine. Alternatively, double click on 
screen. Two detached fragments, methyl chloride and hydrogen 
bromide, appear on screen. Click on  or hold down the Delete 
key and then click on the free valence on bromine. You are left 
with methyl chloride and bromine atom (bromide). Manipulate 
the two such that bromide is poised to attack methyl chloride 
from the backside (as in the transition state above). (Translations 
and rotations normally refer to both fragments, but can be made 
to refer to a single fragment by first clicking on the fragment 
and then holding down on the Ctrl key while carrying out the 
manipulations.) Do not minimize. Click on .

* In this example, you have requested graphical surfaces prior to submitting the calculation. 
You could also have requested them to be done “on-the-fly” following the calculation.
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2. Select Transition State from the Build menu ( ). Click on 
bromide and then click first on carbon and then on bromide. A 
dotted line will be drawn from bromine to carbon, together with 
an arrow from bromine to the center of this line. Next, click on 
the CCl bond and then click on the chlorine, and click a second 
time on chlorine. A second arrow from the carbon-chlorine bond 
to the chlorine will be drawn.

 
Br C Cl

 Click on  (Search Transition State) at the bottom right of the 
screen. Your structure will be replaced by a guess at the transition 
state.

3. Select Measure Distance from the Geometry menu or click on 
 if it appears at the top of the screen and then click on the CBr 

bond. Replace the current CBr distance in the box at the bottom 
right of the screen by 3.8 (3.8Å) and press the Enter button. You 
have made a complex representing the reactant.

4. Select Constrain Distance from the Geometry menu or click on 
 if it appears at the top of the screen. Click on the CBr bond, 

and then click on  at the bottom right of the screen. The icon 
will change to  indicating a constraint is to be applied to this 
distance. Check the box to the left of Profile at the bottom of right 
of the screen. This will result in two additional text boxes.

 
 Leave the value 3.8 (3.8Å) in the leftmost box alone, but change 

the number in the box to the right of to to 1.9 (1.9Å) and press 
the Enter button. Change the number in the box to the right 
of Steps from 10 (the default) to 20. 20 Calculations with CBr 
bond lengths constrained from 3.8Å (the starting point) to 1.9Å 
(the ending point) will be performed. The transition state should 
have a CBr distance in between these values. Click on .
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5. Select Calculations... from the Setup menu ( ), and select 
Energy Profile in Water and Hartree-Fock 3-21G from the 
menus to the right of Calculate. You also need to change Total 
Charge to Anion.

6. Submit the job. Name it bromide+methyl chloride. When 
completed, it will give rise to a sequence of calculations placed 
in a new document with the name bromide+methyl chloride.
Prof.spartan. Accept the prompt to open this file. Close the first 
document bromide+methyl chloride to reduce clutter.

7. Select Spreadsheet from the Display menu ( ). Click on the 
Add button at the bottom of the spreadsheet. Select Relative 
Energy from among the quantities listed under the Molecules 
List tab and kJ/mol. Next, enter the (constrained) CBr distances 
and bromine charges in the spreadsheet. Select Constrain 
Distance from the Geometry menu ( ), click on the constraint 
marker in the model and click on  at the bottom right of the 
screen. Click on . Select Properties from the Display menu 
( ) to bring up a Properties dialog. Click on bromine and 
click on  to the left of Electrostatic Charges in the Atom 
Properties dialog. Close the spreadsheet and select Plots from 
the Display menu ( ) to bring up the Plots dialog. Click on  
in the bar at the top of the dialog and select Constraint (Con1) 
(the distance at which the CBr bond has been constrained) 
from the X Axis menu, and both Relative Energy (kJ/mol) 
and Electrostatic (Br1) from the Y Axes list in the dialog that 
results. Click on Create. By default, the data points are not 
connected. Click on  in the bar at the top of the plots plane, 
select Point-to-Point for both  Relative Energy (kJ/mol) and 
Electrostatic(Br1). Also set the X Axis Range from 4 to 1.8. 
and click on Done.

 One plot gives the energy as the reaction proceeds and the other 
gives charge on bromine. Are the two related? Explain.
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8. SN2 reactions involving charged species normally need to be 
carried out in highly-polar media, for example, water. The 
C-PCM solvent model available with Spartan Student allows 
the effect of solvent to be estimated.

9. Select Surfaces from either the Setup or Display menu ( ). 
Click on More Surfaces.... * Select density (bond) from the 
Surface menu and none from the Property menu and click on 
Apply. Select density (bond) from the Surface menu, but this 
time potential from the Property menu. Click on OK. Do not 
close the Surfaces dialog. The Spartan Student interface will 
perform these graphics calculations on-the-fly, however, it will 
take 30 seconds to a minute to complete the two surfaces for all 
20 molecules on the list.

10. When completed, check the box to the left of the bond density 
surface inside the Surfaces dialog (the first one you specified) to 
turn it on. Click on  at the bottom left of the screen to animate 
the display. Note, that bonds are smoothly broken and formed 
during the course of reaction. Click on  at the bottom of the 
screen when you are done.

11. Turn display of the bond density off (uncheck the box) inside 
the Surfaces dialog, and then turn display of the electrostatic 
potential mapped onto the bond density on. Click on . Relate 

* You need to use More Surfaces rather than Add as the electrostatic potential is mapped on 
the bond density surface.



Tutorial 9 91

the migration of negative charge during reaction as indicated by 
colors in the electrostatic potential map to the plot you constructed 
in step 8. Recall, that colors near red indicate maximum negative 
potential.

12. Remove all molecules and any remaining dialogs from the 
screen.
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Tutorial 10
Biomolecules

The two tutorials in this chapter illustrate models appropriate to 
large biomolecules (proteins and polynucleotides), in particular, 
ribbon displays of secondary structure and display of hydrogen 
bonds. No calculations are performed.

Treatment of very large molecules, proteins and polynucleotides 
(biopolymers) most important among them, requires models which 
are simpler than those appropriate for small organic and inorganic 
molecules. This refers both to structural models for display and 
manipulation (where a simplified ribbon display of the biomolecule’s 
backbone is used) and to theoretical models used for calculation of 
structure and properties (where molecular mechanics replaces quantum 
chemical models).

Structural Motifs in Proteins

Two main themes dominate the 
3-dimensional structures of essentially 
all proteins, the a helix and the b 
sheet.

a Helix

1. Select New Build from the File 
menu ( ) and click on the 
Peptide builder from the Model 
Kit. This contains a library of 
the 20 natural amino acids, each 
identified by a 3-letter code.

2. Click on gly- (glycine). As you 
toggle the checkbox to the left of 
Sequence on and off, the display 



Tutorial 10 93

window at the top of the model kit will shift between a text field 
showing gly (Sequence button checked) and a 2D rendering of 
non-terminated glycine (Sequence button un-checked).

3. Make sure the Sequence box is checked, and randomly select 
an additional 9 amino acid residues. Below the pallet of amino 
acids are a series of buttons: a Helix, b Sheet and Other. These 
allow specification of the secondary structure of constructed 
polypeptide sequences.  Select a Helix and double click on 
screen.

4. A ball-and-spoke model of a 10-residue polypeptide is displayed. 
There are two open valences (indicated by their yellow color) 
at either end of this non-terminated polypeptide molecule.  
From the lower right side of the Peptide builder, click on the 
Terminate button. The dialog that results lets you terminate the 
polypeptide either as an uncharged form (CO2H and NH2) or as 
a zwitterionic form (CO2

–  and NH3
+).

 
 Choose CO2H  and NH2 (the uncharged form) and click on the 

OK button to terminate.

5. To simplify the model, display the molecule as a Tube model and 
deselect Hydrogens from the Model menu. Select Hydrogen 
Bonds from the Model menu. Dotted lines depicting hydrogen 
bonds will appear on screen between the oxygens of carbonyl 
groups and the nitrogens of amine groups (recall that display 
of hydrogens has been turned off). In the a helix structure, 
hydrogen bonds are formed between the C=O of one amino 
acid and NH group of another amino acid, separated by a space 
of 4 residues. It is this network of internal hydrogen bonding 
that holds together the a helix. 
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6. To better see the a helix, select Ribbons from the Model menu. 
You may also, if you choose, turn off the molecular structure 
display of the peptide all together, by selecting Hide from the 
Model menu. Rotate the model on screen to get an idea of its 3D 
structure. Note that the hydrogen bonds are still visible. Close 
the document when you finish examining the a helix structure.

b Pleated Sheet

7. Select New Build from the File menu ( ) and click on the 
Peptide builder from the Model Kit. The ten-residue sequence 
you previously constructed will remain in the viewer window 
at the top of the builder (if not, make sure the Sequence box is 
checked and randomly choose another 9 amino acids). Select b 
Sheet and click on screen.

8. Again, a model of a 10-residue polypeptide is displayed. This 
time, the secondary structure is in the b sheet configuration. 
Terminate the structure in either the uncharged or zwitterionic 
form.

9. Click on  to remove the model kit. Note that the same 
10-residue sequence is significantly longer in the b sheet 
arrangement. As you did for the a helix, switch to a tube model, 
turn hydrogens off and turn on display of hydrogen bonds. The 
extended b sheet does not contain internal hydrogen bonding 
so no hydrogen bonds appear. Close the document when you 
finish examining the b-sheet structure.

10. Hydrogen bonds play a role in connecting b strands to make a b 
sheet. Select Access PDB Online... from the File menu or click 
on ( ) if it appears at the top of the screen.
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 Type 1JIC* into the dialog that results and click on Open. Turn 

on hydrogen bonds (Hydrogen Bonds from the Model menu 
or click on  if it appears at the top of the screen). Hydrogen 
bonds appear between different b strands. Note that hydrogen 
bonds may also exist between residues on the same strand, in this 
example they form a hairpin turn resulting in the same b sheet 
running adjacent to itself but in the opposite (or anti-parallel) 
direction. Close 1JIC when you have finished examining the 
b-sheet structure.

11. Select Access PDB Online... from the File menu ( ), type 
1A3F** into the resulting dialog and click on Open. Note that a 
simple ribbon display, showing the protein backbone (secondary 
structure) has replaced the usual structural models (ball-and-

spoke, tube, etc.). To see why this 
is preferable, turn on (select) one 
of these models from the Model 
menu. The model styles that 
provide detail of the enzyme’s 
primary structure completely 
obscure a significant structural 
detail (namely that this enzyme 
is comprised of three identical 
sub-units). Note, however, that a 

space-filling model (Space-Filling from the Model menu) does 
provide indication of the overall size and shape of the enzyme.

* PDB designation 1JIC. Torres, A.M., Kini, R.M., Selvanayagam, N., Kuchel, P.W.; J. 
Biochem. 360: 539-548 (2001).

** PDB designation 1A3F. Segelke, B.W., Nguyen, D., Chee, R., Xuong, N.H., Dennis, 
E.A.; J.Mol. Bio., 279, 223-232 (1998).
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12. To better visualize the three sub-units, turn the selected model 
style off (choose Hide from the Model menu) and select 
Configure from the Model menu, click on the Ribbons tab, 
select By Strand for Coloring and Extended Ribbons for 
Style and click Apply. Note that each oligomer is colored 
differently. Explore the remaining options for coloring 
(click Apply after each selection). Monochrome provides a 
single colored model useful for tracing the backbone of the 
biomolecule. By Secondary Structure gives information about 
how the backbone is organized (alpha-helices are colored red, 
beta-sheets are colored blue, while any remaining segments are 
colored green). By Residue provides a multi-colored display 
where each unique color represents a specific amino acid residue 
type.  To further explore, click on the OK button to dismiss the 
Configure dialogue, and then click on the individual colored 
segments of the ribbon. The specific peptide or amino acid 
residue (in the case of peptide chains, proteins, or enzymes) 
or nucleotide base (in the case of nucleotide chains, DNA, or 
RNA) will be specified in the lower right of the workspace.

13. Select Ramachandran Plot from the Geometry menu.

 
 Each point gives the dihedral angles between a pair of amino 

acids (the so-called f and y angles). Note that many points fall 
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into two clusters, one corresponding to helices and the other to 
b sheets.

14. Close 1A3F. 

Structure of DNA

Only a single motif, a helix, defines the elegant structure of DNA.

1. Select New Build from the File menu ( ) and click on the 
Nucleotide model kit.

 

 This model kit includes options for building a variety of nucleic 
acid sequences (based on nucleotide residues) included both 
single and double stranded DNA and RNA, as well as hybrid 
DNA-RNA sequences. Choose DNA from the menu in the 
middle of the Nucleotide model kit.
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2. Just below the viewer window (inside the model kit) are four 
buttons designating the nucleotide bases. Click on A (adenine). 
Toggle the check-box to the left of Sequence on and off. The 
display window at the top of the model kit will shift between 
a text field showing A- (with the Sequence button checked) 
and a 2D rendering of adenine (with the Sequence button un-
checked). Note that even though the 2D rendering displays only 
the nucleotide base, when building, the entire nucleotide, include 
the organic base (purine or pyrimidine), sugar (ribose), and 
phosphate group, will be inserted on screen.  In the case of double-
stranded sequences, the complementary base will also be inserted.

3. Double click on screen to insert an adenosine nucleotide, and 
its complementary base thymine nucleotide. Select Hydrogen 
Bonds from the Model menu to display hydrogen bonding 
between the AT base pair. Note that adenosine-thymine pairings 
in double stranded DNA will always form two hydrogen bonds, 
where as guanine-cytosine pairings result in the formation of 
three hydrogen bonds. When you are finished examining the 
A-T base pair, select Clear from the Edit menu.

4. Make sure the Sequence box is checked, and randomly select 
an additional 15-20 nucleotide bases. Below the pallet of 
nucleotide bases  is a series of buttons (marked A, B, and Other) 
that provide for specification of the nucleotide sequence Helix. 
Select B for the helix type and double click on screen. (DNA 
exists in three forms, A, B, and Z. Almost all DNA in living 
organisms is in the B-DNA configuration.)

5. Select Tube and Ribbon from the Model menu. Display of 
hydrogen bonds has already been specified. If you turned this 
off, hydrogen bonds can be accessed from the Model menu. 
Also select Configure from the Model menu or click on  
( ) if it appears at the top of the screen and click on the 
Ribbons tab. Select By Strand from the Coloring options and 
click OK. The ribbon tracing the backbone of the sequence you 
constructed from the builder is colored red; the complementary 
sequence is colored blue.
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6. Because the glycosidic bonds of the base pairs (bonds connecting 
the base pairs to their sugar molecules) are not exactly opposite 
one another, B-DNA has two clearly visible grooves (called the 
major groove and the minor groove). The major groove is ≈ 12 
Å wide and the minor groove is roughly half that size.  Select 
Space-Filling from the Model menu and locate the major and 
minor grooves in your B-DNA sequence.

7. Close all open documents.
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Tutorial 11
Inorganic and  

Organometallic Molecules
This chapter shows how to construct inorganic and organometallic 
molecules using Spartan Student’s inorganic model kit.

Many molecules are made up of a relatively few elements and obey 
conventional valence rules. They may be easily built using the organic 
model kit. However, others cannot be assembled with this model kit 
either because they incorporate other elements, or do not conform 
to normal valence rules or involve ligands. Important among these 
are inorganic and organometallic compounds involving transition 
metals.

1 min

Sulfur Tetrafluoride

S
F

F

F

F

Sulfur tetrafluoride cannot be constructed using Spartan Student’s 
organic model kit. This is because sulfur is not in its normal bent 
dicoordinate geometry, but rather in a trigonal bipyramid geometry 
with one of the equatorial positions vacant. However, the molecule 
can easily be made using the inorganic model kit.

1. Select New Build from the File menu ( ) and then select 
Inorganic from the menu at the top of the model kit.
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 The inorganic model kit comprises a selection bar (initially, 

clicking on the selection bar brings up the Periodic Table) 
followed by a selection of atomic hybrids. Buttons access menus 
of groups, rings and ligands, additional libraries (More) and the 
clipboard. Finally, a selection of bond types is provided at the 
bottom of the model kit.

2. Click on the selection bar to bring up the Periodic Table.

 
 Select (click on) S in the Periodic Table and the five coordinate 

trigonal bipyramid structure  from the list of atomic hybrids. 
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Click on screen. A trigonal bipyramid sulfur will appear at the 
top of the model kit.

3. Again, click on the atom bar, select F in the Periodic Table and 
the one-coordinate entry  from the list of atomic hybrids. 
One after the other, click on both axial free valences of sulfur, 
and two of the three equatorial free valences.

4. It is necessary to delete the remaining free valence (on an equatorial 
position); otherwise it will become a hydrogen. Click on  and 
then click on the remaining equatorial free valence.

5. Click on . Click on  to remove the model kit.

6. Select Calculations... from the Setup menu ( ). Select  
Equilibrium Geometry*, Density Functional, wB97X-D, and 
6-31G* from the menus to the right of Calculate and click on 
Submit. Accept the name sulfur tetrafluoride.

7. When the job completes, select Properties from the Display 
menu ( ) and click on an atom, for example, sulfur. The 
atomic charge based on the electrostatic potential will appear in 
the (Atom Properties) dialog. Are the charges consistent with 
covalent or ionic bonding?

8. Select Surfaces from the Display menu, click on Add and select 
HOMO from the menu that results. The graphics calculation is 
automatic and will take only a second or two. When completed, 
check the box to the left of HOMO inside the Surfaces dialog. 
Is the highest-occupied molecular orbital in sulfur tetrafluoride 
consistent with the notion that sulfur is surrounded by six electron 
pairs? Elaborate.

9. Close sulfur tetrafluoride and any open dialogs.

* It should be noted that were an incorrect geometry specified at the outset, optimization 
would lead to the correct structure, as long as the starting geometry possessed no symmetry 
(C1 point group). Thus, square planar SF4 in D4h symmetry would remain square planar, 
while an almost square planar structure (distorted only slightly from D4h symmetry to C1 
symmetry) would collapse to the proper structure.
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 10 mins

Benzene Chromium Tricarbonyl

Cr
OC CO

CO

benzene chromium tricarbonyl

Does a chromium tricarbonyl group donate or withdraw electrons 
from an aromatic ring to which it is coordinated? The objective of 
this tutorial is to find out by comparing electrostatic potential maps 
for benzene chromium tricarbonyl and free benzene.

1. Select New Build from the File menu ( ) and then Inorganic 
from the menu at the top of the model kit. Click on the selection 
bar and select Cr from the Periodic Table. Select the four-
coordinate tetrahedral structure  from the list of atomic 
hybrids. Click anywhere on screen.

2. Click on Ligands in the model kit, select Benzene from the 
menu of available ligands.

 
 Click on one of the free valences on the four-coordinate chromium 

center. 
3. Select Carbon Monoxide from the Ligands menu, and click on 

the remaining (three) free valences on chromium. Click on  
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to produce a refined structure.

4. Select Build New Molecule from the File menu ( ). Click on 
Rings, select Benzene and click on the screen. Click on  and 
then on . The document now contains both benzene chromium 
tricarbonyl and benzene.

5. Select Calculations... from the Setup menu ( ). Specify 
calculation of Equilibrium Geometry and PM3 from the menus 
to the right of Calculate. Make certain that Global Calculations 
(at the bottom of the dialog) is checked. Click on OK.

6. Select Surfaces from either the Setup or Display menu ( ). 
Click on Add and choose electrostatic potential map from the 
menu. Make certain that Global Surfaces is checked. Do not 
close the Surfaces dialog.

7. Submit the job (Submit from the Setup menu). Name it benzene 
chromium tricarbonyl. When completed select Spreadsheet 
from the Display menu ( ), and check the box to the left of 
the label for both entries. This allows the two molecules to be 
displayed simultaneously on screen. By default, Coupled (Model 
menu) is checked. Remove the checkmark by selecting it. The 
two molecules may now be moved independently. Orient each 
molecule so that you can clearly see the benzene face (exposed 
face in the case of the organometallic).

8.  Check electrostatic potential map in the Surfaces dialog. Compare 
electrostatic potential maps for both free and complexed benzene, 
with attention to the exposed benzene face.* Does the Cr(CO)3 
group donate or withdraw electrons from the ring? Would you 
expect the aromatic ring in benzene chromium tricarbonyl to be 
more or less susceptible to electrophilic attack than free benzene? 
More or less susceptible to nucleophilic attack?

9. Close the documents and any open dialogs.

* Electrostatic potential maps (as well as other maps) for molecules in a group will be put onto 
the same (color) scale. This allows comparisons to be made among different members.
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5 mins

Ziegler-Natta Polymerization of Ethylene

Ziegler-Natta polymerization involves a metallocene. This complexes 
an olefin, which then inserts into the metal-alkyl bond.

Cp2Zr+R Cp2Zr+R
H2C CH2 Cp2Zr+CH2CH2R

H2C CH2 H2C CH2

RCp2Zr+

The object of this tutorial is to obtain a transition state for insertion 
of ethylene into Cp2ZrCH3

+.

1. Select New Build from the File menu ( ) and then Inorganic 
from the menu at the top of the model kit. Click on the selection 
bar and select Zr from the Periodic Table. Select  from the 
list of hybrids and click on screen. Select Cyclopentadienyl 
from the Ligands menu and click on two of the free valences 
on zirconium. 

2. Select Organic from the menu at the top of the model kit to move  
to the organic model kit. Select sp3 carbon  and click on 
the remaining free valence on zirconium. Select Alkenyl from the 
Groups menu, hold down the Insert key (option key on Mac) and 
click anywhere on screen or double click in a blank area on screen.

3. Orient the two fragments (Cp2ZrCH3 and ethylene) as shown 
below:

 
Zr CH3

Cp

Cp

H2C CH2

 (To move the fragments independently, hold down the Ctrl key.)

4. Select Transition State from the Build menu ( ). Click on 
the ZrC (methyl) bond, and then one after another, click on the 
methyl carbon and on one of the ethylene carbons. Next, click 
on the ethylene double bond and then, one after another, click 
on the other ethylene carbon and on zirconium. Click on  
(Search Transition State) at the bottom right of the screen. In a 
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few seconds, a guess at the transition state appears.

5. Select Calculations... from the Setup menu ( ). Specify 
Transition State Geometry and PM3 from the menus to the 
right of Calculate. Change Total Charge to Cation and check 
IR. Click on Submit and name the job Cp2ZrMe cation + 
ethylene.

6. When the job has completed, select Spectra from the Display 
menu ( ). Click on the  in the bar at the top of the spectra 
pane and select  (calculated IR Spectrum). The infrared 
spectrum calculated for the transition state appears. Click on 

 (Tables) at the far left of the spectra pane. This brings up a 
list of calculated frequencies and infrared intensities. Note that 
the frequency value at the top of the list is preceeded by an “i”. 
This designates it as imaginary. Click on this frequency and 
examine the vibrational motion. Would you describe the process 
as concerted or occurring in discrete steps?

7. Close Cp2ZrMe cation + ethylene and any open documents and 
dialogs.


